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Introduction
MapleSim Overview
MapleSimTM is a modeling environment for creating and simulating complex multi-domain
physical systems. It allows you to build component diagrams that represent physical systems
in a graphical form. Using both symbolic and numeric approaches, MapleSim automatically
generates model equations from a component diagram and runs high-fidelity simulations.
Build Complex Multi-domain Models
You can use MapleSim to build models that integrate components from various engineering
fields into a complete system. MapleSim features a library of over 300 modeling components,
including electrical, hydraulic, mechanical, and thermal devices; sensors and sources; and
signal blocks. You can also create custom components to suit your modeling and simulation
needs.
Advanced Symbolic and Numeric Capabilities
MapleSim uses the advanced symbolic and numeric capabilities of MapleTM to generate
the mathematical models that simulate the behavior of a physical system. You can, therefore,
apply simplification techniques to equations to create concise and numerically efficient
models.
Pre-built Analysis Tools and Templates
MapleSim provides various pre-built templates in the form of Maple worksheets for viewing
model equations and performing advanced analysis tasks, such as parameter optimization.
To analyze your model and present your simulation results in an interactive format, you
can use Maple features such as embedded components, plotting tools, and document creation
tools. You can also translate your models into C code and work with them in other applications and tools, including real-time simulation.
Interactive 3-D Visualization Tools
The MapleSim 3-D visualization environment allows you to view animated 3-D graphical
representations of your multibody mechanical system models. You can use this environment
to validate the 3-D configuration of your model and visually analyze the system behavior
under different conditions.
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Related Products
MapleSim requires the latest version of Maple 13.
MaplesoftTM also offers a suite of toolboxes, add-ons, and other applications that extend
the capabilities of Maple and MapleSim for engineering design projects.
For a complete list of products, visit http://www.maplesoft.com/products.

Related Resources
Resource

Description

MapleSim Installation Guide

System requirements and installation instructions for MapleSim.
The MapleSim Installation Guide is available in the Install.html
file on your MapleSim installation DVD.
Provides the following information:
• MapleSim User's Guide: conceptual information about
MapleSim, an overview of MapleSim features, and tutorials
to help you get started.

MapleSim Help System

MapleSim Examples

•

Using MapleSim: help topics for model building, simulation,
and analysis tasks.

•

MapleSim Library Reference Guide: descriptions of the
modeling components available in MapleSim.

Sample models from various engineering domains. These models
are available in the Examples palette in the Components tab on
the left side of the MapleSim window.
Training webinars, product demonstrations, videos, sample applications, and more.

MapleSim Online Resources

MapleSim Application Center

For more information, visit
http://www.maplesoft.com/products/maplesim.
A collection of sample models, custom components, and analysis
templates that you can download and use in your MapleSim projects.
For more information, visit
http://www.maplesoft.com/applications/maplesim.

For additional resources, visit http://www.maplesoft.com/site_resources.

Getting Help
To request customer support or technical support, visit http://www.maplesoft.com/support.
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Customer Feedback
Maplesoft welcomes your feedback. For comments related to the MapleSim product documentation, contact doc@maplesoft.com.
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1 Getting Started with MapleSim
In this chapter:
•

Physical Modeling in MapleSim (page 1)

•

The MapleSim Screen (page 5)

•

Basic Tutorial: Modeling an RLC Circuit and DC Motor (page 6)

1.1 Physical Modeling in MapleSim
Physical modeling, or physics-based modeling, incorporates mathematics and physical laws
to describe the behavior of an engineering component or a system of interconnected components. Since most engineering systems have associated dynamics, the behavior is typically
defined with ordinary differential equations (ODEs).
To help you develop models quickly and easily, MapleSim provides the following features:
Topological or “Acausal” System Representation
The signal-flow approach used by traditional modeling tools requires system inputs and
outputs to be defined explicitly. In contrast, MapleSim allows you to use a topological
representation to connect interrelated components without having to consider how signals
flow between them.
Mathematical Model Formulation and Simplification
A topological representation maps readily to its mathematical representation and the symbolic capability of MapleSim automates the generation of system equations.
When MapleSim formulates the system equations, several mathematical simplification tools
are applied to remove any redundant equations and multiplication by zero or one. The simplification tools then combine and reduce the expressions to get a minimal set of equations
required to represent a system without losing fidelity.
Advanced Differential Algebraic Equation Solvers
Algebraic constraints are introduced in the topological approach to model definition. Problems that combine ODEs with these algebraic constraints are called Differential Algebraic
Equations (DAEs). Depending on the nature of these constraints, the complexity of the DAE
problem can vary. An index of the DAEs provides a measure of the complexity of the
problem. Complexity increases with the index of the DAEs.
The development of generalized solvers for complex DAEs is the subject of much research
in the symbolic computation field. With Maple as its computation engine, MapleSim uses

1
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advanced DAE solvers that incorporate leading-edge symbolic and numeric techniques for
solving high-index DAEs.

Acausal and Causal Modeling
Real engineered assemblies, such as motors and powertrains, consist of a network of interacting physical components. They are commonly modeled in software by block diagrams.
The lines connecting two blocks indicate that they are coupled by physical laws.
When simulated by software, block diagrams can either be causal or acausal. Many simulation
tools are restricted to causal (or signal-flow) modeling. In these tools, a unidirectional signal,
which is essentially a time-varying number, flows into a block. The block then performs a
well-defined mathematical operation on the signal and the result flows out of the other side.
This approach is useful for modeling systems that are defined purely by signals that flow
in a single direction, such as control systems and digital filters.

This approach is analogous to an assignment, where a calculation is performed on a known
variable or set of variables on the right hand side and the result is assigned to another variable
on the left:

Modeling how real physical components interact requires a different approach. In acausal
modeling, a signal from two connected blocks travels in both directions. The programming
analogy would be a simple equality statement:

The signal includes information about which physical quantities (for example, energy, current,
torque, heat and mass flows) must be conserved. The blocks contain information about
which physical laws (represented by equations) they must obey and, hence, which physical
quantities must be conserved.

MapleSim allows you to use both approaches. You can simulate a physical system (with
acausal modeling) together with the associated logic or control loop (with causal modeling)
in a manner that suits either task best.

Through and Across Variables • 3

Through and Across Variables
When using the acausal modeling approach, it is useful to identify the through and across
variables of the component you are modeling. In general terms, an across variable represents
the driving force in a system and a through variable represents the flow of a conserved
quantity:

For example, in an electrical circuit, the through variable, i, is the current and the across
variable, V, is the voltage drop:

The following table lists some examples of through and across variables for other domains:
Domain

Through

Across

Electrical

Current (A)

Voltage (V)

Mechanical (translational)

Force (N)

Velocity (m/s)

Mechanical (rotational)

Torque (N.m)

Angular Velocity (rad/s)

Hydraulic

Flow (

Heat flow

Heat flow (W)

/s)

Pressure (N/

)

Temperature (K)

As a simple example, the form of the governing equation for a resistor is

This equation, in conjunction with Kirchhoff’s conservation of current law, allows a complete
representation of a circuit.
and
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To extend this example, the following schematic diagram describes an RLC circuit, an
electrical circuit consisting of a resistor, inductor, and a capacitor connected in series:

If you wanted to model this circuit manually, it can be represented with the following
characteristic equations for the resistor, inductor, and capacitor respectively:

By applying Kirchhoff's current law, the following conservation equations are at points a,
b, and c:

These equations, along with a definition of the input voltage (defined as a transient going
from 0 to 1 volt, 1 second after the simulation starts)

provide enough information to define the model and solve for the voltages and currents
through the circuit.
In MapleSim, all of these calculations are performed automatically; you only need to draw
the circuit and provide the component parameters. These principles can be applied equally
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to all engineering domains in MapleSim and allow you to connect components in one domain
with components in others easily.
In the Basic Tutorial: Modeling an RLC Circuit and DC Motor (page 6) section of this
chapter, you will model the RLC circuit described above. The following image shows how
the RLC circuit diagram appears when it is built in MapleSim.

1.2 The MapleSim Screen
The MapleSim screen contains the following panes and components:

Component

Description

1. Main toolbar

Contains tools for running a simulation, viewing documents attached
to your model, and performing other common tasks.
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Component

Description

2. Navigation toolbar

Contains tools for navigating your model and subsystems hierarchically, and changing the model view.

3. Drawing and layout toolbar

Contains tools for laying out and selecting objects, and adding elements such as annotations and probes.

4. Palettes pane

Contains expandable menus with tools to help you build a model and
manage your MapleSim project. This pane contains two tabs:
• Components tab: contains palettes with sample models and domain-specific components that you can add to a model.
•

Project tab: contains palettes with tools to help you browse and
build a model, and manage simulation results.

5. Model workspace

The area in which you build and edit a model.

6. Console

Contains the following panes:
• Message Console pane: displays progress messages indicating
the status of the MapleSim engine during a simulation.
•

Help pane: displays the context-sensitive help topic associated
with a modeling component.

Contains the following tabs:
• Inspector tab: allows you to view and edit modeling component
properties, such as names and parameter values, and specify
simulation parameters.
7. Parameters pane

•

Plots tab: allows you to define custom layouts for simulation
graphs and plot windows.

The contents of this pane change depending on your selection in the
model workspace.

1.3 Basic Tutorial: Modeling an RLC Circuit and DC
Motor
This tutorial is intended to familiarize you with the MapleSim component library and basic
model development tools. It illustrates the ability to mix causal models with acausal models.
In this tutorial, you will perform the following tasks:
1. Build an RLC circuit model.
2. Set parameter values to specify component properties.
3. Add probes to identify data values of interest for the simulation.
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4. Simulate the RLC circuit model.
5. Modify the RLC circuit diagram to create a simple DC motor model.
6. Simulate the DC motor model under different conditions.

Building an RLC Circuit Model
To build a model, you add components to the model workspace and connect them in a system.
In this example, the RLC circuit model contains ground, resistor, inductor, capacitor, and
signal voltage source components from the Electrical library. It also contains a step input
source, which is a signal generator that drives the input voltage level in the circuit.
1. In the Components tab located at the left of the model workspace, click the triangle beside
Electrical to expand the palette. In the same way, expand the Analog menu, and then expand
the Passive submenu.

2. From the Electrical → Analog → Passive menu, drag the Ground component to the
model workspace.
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3. Add the remaining electrical components to the model workspace.
•

From the Electrical → Analog → Passive→ Resistors menu, add the Resistor component.

•

From the Electrical → Analog → Passive → Inductors menu, add the Inductor
component.

•

From the Electrical → Analog → Passive → Capacitors menu, add the Capacitor
component.

•

From the Electrical → Analog → Sources → Voltage menu, add the Signal Voltage
component.

4. Drag the components in the arrangement shown below.

1.3 Basic Tutorial: Modeling an RLC Circuit and DC Motor • 9

5. To rotate the Signal Voltage component clockwise, right-click (Control-click for
Macintosh®) the Signal Voltage component in the model workspace and select Rotate
Clockwise
6. To flip the component horizontally, right-click (Control-click for Macintosh) the component again and select Flip Horizontal. Make sure that the positive (blue) port is at the
top.
7. To rotate the Capacitor component clockwise, right-click (Control-click for Macintosh)
the Capacitor icon in the model workspace and select Rotate Clockwise.
You can now connect the modeling components to define interactions in your system.
8. Hover your mouse pointer over the Ground component port. The port is highlighted in
green.

9. Click the Ground input port to start the connection line.
10. Hover your mouse pointer over the negative port of the Signal Voltage component.

11. Click the port once. The Ground component is connected to the Signal Voltage component.
12. Connect the remaining components in the arrangement shown below.

You can now add a source to your model.
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13. Expand the Signal Blocks palette. Expand the Sources menu and then expand the Real
submenu.
14. From the palette, drag the Step source and place it to the left of the Signal Voltage
component in the model workspace.
The step source has a specific signal flow, which is represented by the arrows on the connections. This flow causes the circuit to respond to the input signal.
15. Connect the Step source to the Signal Voltage component. The complete RLC circuit
model is displayed below.

Specifying Component Properties
To specify component properties, you set parameter values for components in your model.
1. In the model workspace, click the Resistor component. The Inspector tab at the right of
the model workspace displays the name and parameter values of the resistor.
2. In the R field, enter 24, and press Enter. The resistance is changed to 24

3. Specify the following parameter values for the other components. You can specify units
for a parameter by selecting a value from the drop-down menu found beside the parameter
value field.
•

For the Inductor, specify an inductance of

•

For the Capacitor, specify a capacitance of

.
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•

For the Step source, specify a

value of 0.1 s.

Adding Probes
To specify data values for a simulation, attach probes to lines or ports to the model. In this
example, you will measure the voltage of the RLC circuit.
1. From the drawing and layout toolbar, click the probe button (

).

2. Hover your mouse pointer over the line that connects the Inductor and Capacitor components. The line is highlighted.
3. Left-click the line once. The Select probe properties dialog box is displayed.
4. To include the voltage quantity in the simulation graph, select the Voltage check box.
5. To display a custom name for this quantity in the model workspace, in the Voltage field,
enter Voltage.

6. Click OK. The probe is added to the connection line.

7. Drag the probe to position it on the line.
8. Click the probe once to place it on the line.

Simulating the RLC Circuit Model
To simulate a model, specify the duration for which to run the simulation.
1. Click a blank area in the model workspace.
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2. In the Inspector tab at the right of the model workspace, set the simulation end time (

)

to 0.5 seconds and press Enter.
3. Click the simulation button ( ) in the main toolbar. MapleSim generates the system
equations and simulates the response to the step input.
When the simulation is complete, the voltage response is plotted in a graph.

4. Save the model as RLC_Circuit1.msim. The probes and modified parameter values are
saved as part of the model.

Building a Simple DC Motor Model
You will now add an electromotive force (EMF) component and a mechanical inertia
component to the RLC circuit model to create a DC motor model. In this example, you will
add components to the RLC circuit model using the search feature.
1. In the Search field located above the palettes, type EMF. A drop-down menu displays
your search results.

2. Select Rotational EMF from the drop-down menu. The Rotational EMF component is
displayed in the square beside the search field.
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3. From the square beside the search field, drag the Rotational EMF component to the
modeling workspace and place it to the right of the Capacitor component.
4. In the search pane, search for Inertia.
5. Add the Inertia component to the model workspace and place it to the right of the Rotational EMF component.
6. Connect the components as shown below.

To connect the positive blue port of the Rotational EMF component, click the port once,
drag your mouse pointer to the line connecting the capacitor and inductor, and click the
line.
7. In the model workspace, click the Rotational EMF component.
8. In the Inspector tab, change the value of the transformation coefficient (k) to 10
9. Click the Step component and change the value of the parameter,

.

, to 1.

Simulating the DC Motor Model
1. In the model workspace, delete Probe1.
2. From the drawing and layout toolbar, click the probe button (

).

3. Hover your mouse pointer over the line that connects the Rotational EMF and Inertia
components.
4. Left-click the line once.
5. In the Select probe properties dialog box, select the Speed and Torque check boxes.
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6. Click OK. The probe, with an arrow indicating the direction of the conserved quantity
flow, is added to the model.
7. Click a blank area in the model workspace.
8. In the Inspector tab, set the simulation end time (
button ( ) in the main toolbar.
The following graphs are displayed.

9. Save the model as DC_Motor1.msim.

) to 5 seconds and click the simulation

2 Building a Model
In this chapter:
•

The MapleSim Component Library (page 15)

•

Browsing a Model (page 16)

•

Defining How Components Interact in a System (page 18)

•

Specifying Component Properties (page 19)

•

Creating and Managing Subsystems (page 21)

•

Global and Subsystem Parameters (page 28)

•

Creating and Managing Custom Libraries (page 35)

•

Annotating a Model (page 37)

•

The MapleSim Document Folder (page 40)

•

Creating a Data Set for an Interpolation Table Component (page 41)

•

Best Practices: Building a Model (page 42)

2.1 The MapleSim Component Library
The MapleSim component library contains over 300 components that you can use to build
models. Most of these components are based on the Modelica® Standard Library and organized in palettes according to their respective domains: electrical, hydraulic, 1-D and multibody
mechanical, thermal, and signal blocks.
Library

Description

Electrical

Components to model electrical analog circuits, single-phase and
multiphase systems, and electric machines.

Hydraulic

Components to model hydraulic systems such as fluid power
systems, cylinders, and actuators.

1-D Mechanical

Components to model 1-D translational and rotational systems.

Multibody Mechanical

Components to model multibody mechanical systems, including
force, motion, and joint components.

Signal Blocks

Components to manipulate or generate input and output signals.

Thermal

Components to model heat flow and heat transfer.

The library also contains sample models that you can view and simulate, for example,
complete electrical circuits and filters. For more information about the MapleSim library

15
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structure and modeling components, see the MapleSim Library Reference Guide in the
MapleSim help system.
To extend the default library, you can also create a custom modeling component from a
mathematical model and add it to a custom library. For more information, see Creating
Custom Modeling Components (page 47).

Viewing Help Topics Associated With Components
In the Help pane located below the model workspace, you can view the help topic associated
with each component from the MapleSim component library. To open a help page, perform
one of the following tasks:
•

Right-click (Control-click for Macintosh) a modeling component in any of the palettes
and select Help from the context menu.

•

Select a component that you have added to the model workspace and press F2.

Alternatively, you can search for and view the help pages for components in the MapleSim
help system.

2.2 Browsing a Model
Using the Model Tree palette or model navigation controls, you can browse your model to
view hierarchical levels of components in the model workspace. You can browse to the top
level for an overall view of your system. The top level is the highest level of your model:
it represents the complete system, which can include modeling components and subsystem
blocks. You can also browse to sublevels in your model to view the contents of individual
subsystems or components.

Model Tree
To browse the hierarchical structure of your model, you can use the Model Tree palette in
the Project tab located at the left of the model workspace. Each node in the model tree
represents a modeling component, subsystem, or connection port in your model. For example,
the model tree of a DC motor is shown below.
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To browse your model and view the parameters associated with a particular component or
subsystem, expand and double-click the nodes in the model tree. You can double-click the
Main node to view the top level of your model and the child nodes to view the contents of
a component or subsystem.

Model Navigation Controls
Alternatively, you can use the model navigation controls located above the drawing and
layout toolbar to browse between modeling components, subsystems, and hierarchical levels
in your model.

From the drop-down menu, select the name of the subsystem or modeling component that
you want to view in the model workspace. You can click the Main button to browse to the
top level of your model. If your model contains subsystems, you can also use these controls
to browse directly to a particular subsystem (for example, by clicking the
button in the example shown above, you can view the DC motor components in the model
workspace).
Both the model tree and model navigation controls can help you to create hierarchical levels
of modeling components. For example, you can browse to a subsystem node and then add
and connect modeling components at that sublevel.
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2.3 Defining How Components Interact in a System
To define interactions between modeling components, you connect them in a system. You
can draw a connection line between two connection ports.

You can also draw a connection line between a port and another connection line.

MapleSim permits connections between compatible domains only. By default, each line
type is displayed in a domain-specific color.
Domain

Line Color

Mechanical 1-D rotational

Black

Mechanical 1-D translational

Green

Mechanical multibody

Black

Electrical analog

Blue

Electrical multiphase

Blue

Digital logic

Purple

Boolean signal

Pink

Causal signal

Navy blue

Integer signal

Orange

Thermal

Red

The connection ports for each domain are also displayed in specific colors and shapes.
Domain

Positive Connector/Input

Negative Connector/Output

Electrical analog

Solid blue square

Square with a blue outline

Electrical multiphase

Solid blue circle

Circle with a blue outline

1-D rotational mechanical Solid gray circle

Circle with gray outline
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Domain

Positive Connector/Input

Negative Connector/Output

1-D translational mechanicSolid green square
al

Square with a green outline

Multibody mechanical

Solid gray rectangle

Rectangle with a gray outline

Hydraulic

Solid blue circle within a square
with a red outline

Circle with a blue outline within a
square with a red outline

Real signal

Solid navy blue triangle

Triangle with a navy blue outline

Thermal

Solid red square

Square with a red outline

Digital signal

Solid purple square or rectangle

Triangle with a purple outline

Boolean signal

Solid pink triangle

Triangle with a pink outline

Integer signal

Solid orange triangle

Triangle with an orange outline

For more information about connection ports, see the MapleSim Library Reference →
Connectors Overview topic in the MapleSim help system.

2.4 Specifying Component Properties
To specify component properties, you can set parameter values for individual components
in your model. When you select a component in the model workspace, the configurable
parameter values for that component are displayed in the Inspector tab located at the right
of the model workspace. Not all components provide parameter values that you can edit.
You enter parameter values in 2-D math notation, which is a formatting option that allows
you to add mathematical elements such as superscripts, subscripts, and Greek characters.
For more information, see Entering Text in 2-D Math Notation (page 39).

Specifying Parameter Units
You can use the drop-down menus beside parameter fields with dimensions to specify units
for parameter values. For example, the image below displays the configurable parameter
fields for a Sliding Mass component. You can optionally specify the mass in kg, lb , ,
or slug, and the length in m, cm, mm, ft, or in.
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When you simulate a model, MapleSim automatically converts all parameter units to the
International System of Units (SI). You can, therefore, select more than one system of units
for parameter values throughout a model.
If you want to convert the units of a signal, use the Unit Conversion Block component
from the Signal Converters menu in the Signal Blocks palette. This component allows
you to perform conversions in dimensions such as time, temperature, velocity, pressure,
and volume. In the following example, a Unit Conversion Block component is connected
between a translational Position Sensor and Feedback component to convert the units of
an output signal.

If you include an electrical, 1-D mechanical, hydraulic, or thermal sensor in your model,
you can also select the units in which to generate an output signal.

Specifying Initial Conditions
You can set parameter values to specify initial conditions for many electrical, hydraulic,
and 1-D mechanical components, including capacitors, hydraulic pipes, and mechanical
springs and dampers. When you select a component that contains state variables in the
model workspace, the available initial condition fields are displayed in the Inspector tab,
along with the other configurable parameter values for that component.
For example, the image below displays the initial velocity and position fields that you can
set for a Sliding Mass component.
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2.5 Creating and Managing Subsystems
A subsystem (or compound component) is a set of modeling components that are grouped
in a single block component. A sample DC motor subsystem block is shown below.

You can create a subsystem to group components that form a complete system, for example,
a tire or DC motor. You can also create a subsystem to improve the layout of a diagram in
the model workspace, add multiple instances of a system to a model, or to analyze a component grouping in Maple. Also, you can organize your model hierarchically by creating
subsystems within other subsystems.
For more information, see Best Practices: Laying Out and Creating Subsystems (page 42).

Example: Creating a Subsystem
In the following example, you will group the electrical components of a DC motor model
into a subsystem block.
1. In the Components tab located at the left of the model workspace, expand the Examples
palette, expand the Tutorial menu, and then open the Simple DC Motor example.
2. Using the selection tool (
the electrical components.

) located above the model workspace, draw a box around
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3. From the Edit menu, select Create Subsystem.
4. In the Create Subsystem dialog box, enter DC Motor.
5. Click OK. A white block, which represents the DC motor, is displayed in the model
workspace.

Viewing the Contents of a Subsystem
To view the contents of a subsystem, double-click the subsystem icon in the model workspace. The detailed view of a subsystem is displayed.
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In this view, a broken line indicates the subsystem boundary. You can edit the connection
lines and components within the boundary, add and connect components outside of the
boundary, and add subsystem ports to connect the subsystem to other components. If you
want to resize the boundary, click the broken line and drag one of the sizing handles displayed
around the box.
To browse to the top level of the model or to other subsystems, use the model navigation
controls in the navigation toolbar.

Managing Subsystems
When you add components to the model workspace and create a subsystem, entries are added
to the Library Models palette located in the Project tab at the left of the model workspace.
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This palette contains two menus:
•

User menu: displays a history of subsystems that you created for the current model.

•

Library menu: displays a history of modeling components that you added to the current
model, including components in subsystems.

You can use these menus to keep track of the subsystems that you create and edit. If you
delete a subsystem in the model workspace, its corresponding entry remains in the User
menu until you close the file or remove the entry by right-clicking it (Control-click for
Macintosh) and selecting Remove from the context menu.
Notes:
•

Entries cannot be removed from the User menu if copies of the corresponding subsystem
are in the model workspace.

•

No entries can be removed from the Library menu.

Adding Multiple Copies of a Subsystem to a Model
You can add multiple copies of a subsystem to a model by dragging an entry from the
Library Models palette to the model workspace.
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When you create a new subsystem or add a copy of a subsystem, a unique subscript number
is appended to the subsystem name displayed in the model workspace. As shown in the
image above, unique subscript numbers are appended to the names of each copy of the DC
Motor subsystem. These numbers can help you to differentiate multiple subsystem copies
in your model.
You can also copy and paste subsystems from one MapleSim file to another.

Editing Copied Subsystems
When you edit a copy of a subsystem in the model workspace (for example, edit a parameter
value or add a shape to change the appearance of the subsystem icon), note the following:
•

If you edit a subsystem copy in the model workspace, any new copies that you drag
from the Library Models palette will contain the changes.

•

If you edit a subsystem copy when corresponding subsystem copies are already in the
model workspace, all of the corresponding subsystem copies that are already in the
model workspace will inherit the change.

•

If you edit a subsystem copy that you pasted into another file, your changes are reflected
only in subsystem copies in the file that you edit; corresponding subsystem copies in
other files will be unaffected.

Example: Editing Copied Subsystems
In this example, you will modify the resistance values and subsystem icons in a model that
contains multiple DC motor subsystems called RobotMotor. When you change the resistance
value in one RobotMotor subsystem, the other RobotMotor subsystem and any subsystem
copies that you add will inherit the changes.
To start, both RobotMotor subsystems in this model have a resistance value of 30

.

1. In the Components tab at the left of the model workspace, expand the Examples palette,
expand the Multidomain menu, and then open the Sumobot example.
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2. In the model workspace, double-click one of the RobotMotor subsystems. The detailed
view of the subsystem is displayed.
3. Select the Resistor component (
value to 50

) and, in the Inspector tab, change the resistance

.

4. From the navigation toolbar, click the

button to switch to the icon view.

5. Using the
tool located in the drawing and layout toolbar, click and drag your mouse
pointer to draw a shape in the box.

6. From the navigation toolbar, click the

button to return to the diagram view.

7. Click Main in the navigation toolbar to browse to the top level of the model. Both copies
of the RobotMotor subsystem now display the square that you drew.
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8. In the Project tab at the left of the model workspace, expand the Library Models palette,
and then expand the User menu. As shown in the image below, your changes are also reflected in the RobotMotor entry displayed in this palette.

If you double-click the RobotMotor subsystem blocks in the model workspace and select
their Resistor components, you will also see that both of the copies now have a resistance
value of 50
9. From the Library Models palette, drag a new copy of the RobotMotor subsystem and
place it anywhere in the model workspace. The new copy displays the square that you drew
and its resistance value is also 50

.

Example: Editing a Particular Subsystem Copy
If your model contains multiple subsystem copies and you want to edit one copy only, you
can duplicate the subsystem entry in the Library Models palette and then add that duplicated
entry to your model. You can then edit the subsystem without affecting other entries in the
model workspace.
1. In the Components tab at the left of the model workspace, expand the Examples palette,
expand the Multidomain menu, and then open the Sumobot example.
2. In the Project tab at the left of the model workspace, expand the Library Models palette,
and then expand the User menu.
3. Right-click (Control-click for Macintosh) the RobotMotor subsystem.
4. Select Duplicate.
5. In the Rename Subsystem dialog box, enter RobotMotor2 and click OK. A copy of the
subsystem is displayed in the palette.
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6. From the Library Models palette, drag a RobotMotor2 subsystem copy into the model
workspace.
7. In the navigation toolbar, click the

button to switch to the icon view.

8. Using the
tool, click and drag your mouse pointer to draw a shape in the box in the
model workspace.
9. Browse to the top level of the model. Note that your change is not reflected in the RobotMotor subsystem instances in your model.
You can replace a RobotMotor subsystem that is already in the model workspace with a
RobotMotor2 subsystem to include a modified version of the subsystem in your model.

2.6 Global and Subsystem Parameters
Global Parameters
If your model contains multiple components that share a common parameter value, you can
optionally create a global parameter. A global parameter allows you to define a common
parameter value in one location and then assign that common value to multiple components
in your model. When you edit the global parameter value, any components that have been
assigned that common parameter value will inherit the changes. As a result, instead of
changing the parameter values for each component individually, you would only need to
change the value of the global parameter in one location.
The example described below illustrates how to define and assign a global parameter. To
view a more detailed example, see Tutorial 1: Modeling a DC Motor with a Gearbox (page 83) in Chapter 6 of this guide.
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Example: Defining and Assigning a Global Parameter
If your model contains multiple Resistor components that have a common resistance value,
you can define a global parameter for the resistance value in the parameter editor view.
1. In the Components tab, expand the Electrical palette, expand the Analog menu, expand
the Passive menu, and then expand the Resistors menu.
2. From the palette, drag three copies of the Resistor component into the model workspace.

3. Click
in the navigation toolbar to switch to the parameter editor view. You will use
this screen to define the global parameter and assign it to the Resistor components in your
model.

4. Click New Parameter in the Main subsystem default settings table.
5. Enter GlobalResistance as the global parameter name and press Enter.
6. Specify a default value of 2 and enter Global resistance variable as the description.
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The global parameter for the resistance value is now defined. You can now assign the
common GlobalResistance parameter value to the individual Resistor components that
you added to the model workspace.
7. In the

component table and

component table, enter GlobalResistance as the

resistance value.

The resistance value of the parameter GlobalResistance (2, as defined in the Main subsystem default settings table) has now been assigned to the resistance parameters of the
and

components.

The

and

components will now inherit any changes made to the GlobalResistance

parameter value in the Main subsystem default settings table. For example, if you change
the default value of the GlobalResistance parameter to 5 in the Main subsystem default
settings table, the resistance parameters of the
and
components will also be changed
to 5. Any change to the GlobalResistance parameter value would not apply to the
component because it has not been assigned GlobalResistance as a parameter value.

Subsystem Parameters
You can create a subsystem parameter if you want to create a common parameter value that
is shared by multiple components in a subsystem. Similar to global parameters, a subsystem
parameter is a common value that you define in the parameter editor view and assign to
components.
However, subsystem parameters can only be assigned to modeling components in the subsystem in which they are defined. If you double-click a subsystem block in the model
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workspace, click , and define a parameter in the parameter editor view, the parameter
that you define can only be assigned to components in the subsystem that you double-clicked
and any nested subsystems.
Note: If you define a subsystem parameter and assign its value to a component at the top
level, the component at the top level will not inherit the subsystem parameter value.
To view an example, see Tutorial 3: Modeling a Nonlinear Damper (page 93) in Chapter
6 of this guide.

Creating Parameter Blocks
As an alternative to defining subsystem parameters using the methods described above, you
can create a parameter block to define a set of subsystem parameters and assign them to
components in your model. Parameter blocks allow you to reuse sets of parameter values
in multiple models.
The following image shows a parameter block that has been added to the model workspace.

When you double-click this block, the parameter editor view is displayed. This view allows
you to define parameter values for the block.

After defining parameter values, you can assign those values to the component parameters
in your model.
To use parameter values in another model, you can add a parameter block to a custom library.
For more information about custom libraries, see Creating and Managing Custom Libraries (page 35).
Notes:
•

Parameter blocks must be placed in the same subsystem as the components to which
you want to assign the parameter value.

•

Parameter blocks at the same hierarchical level in a model cannot have the same parameter names. For example, two separate parameter blocks in the same subsystem cannot
each contain a parameter called mass.
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Example: Creating and Using a Parameter Block
In this example, you will create a set of parameters that can be shared by multiple components
in your model. By creating a parameter block, you only need to edit parameter values in
one location to compare results when you run multiple simulations.
1. In the Components tab at the left of the model workspace, expand the Examples palette,
expand the Mechanical menu, and then open the PreLoad example.
2. From the drawing and layout toolbar, click the

button.

3. Click a blank area in the model workspace. The Create Parameter Block dialog box is
displayed.
4. Specify a parameter block name SlidingMassParams and click OK.

5. Double-click the SlidingMassParams parameter block in the model workspace. The
parameter editor view is displayed.

6. Click the New Parameter field and define a parameter called MASS.
7. Press Enter.
8. Specify a default value of 5 and enter the description Mass of the sliding mass.
9. In the same way, define the following parameters and values in the SlidingMassParams
subsystem default settings table.
Name

Default
Value

Description

LENGTH

2

Length of the sliding mass.

1

Initial velocity of the sliding mass.

1

Initial position of the sliding mass.
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Tip: To enter a subscript, press Ctrl + Shift + the underscore key (Windows® and Linux®)
or Command + Shift + the underscore key (Macintosh) and type the value to include in
the subscript. To move the cursor out of the subscript position, press the right arrow key on
your keyboard.
The parameter editor view appears as follows when the values are defined.

10. To switch to the diagram view, click Main in the navigation toolbar. When you click
the parameter block in the model workspace, the parameters that you defined are displayed
in the Inspector tab at the right of the model workspace.
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11. In the model workspace, select one of the Sliding Mass components in the diagram.
12. In the Inspector tab, assign the following values.

The parameters of this Sliding Mass component now inherit the numeric values that you
defined in the parameter block.
13. In the same way, assign the same values to the parameters of the other Sliding Mass
components in the model.
14. In the model workspace, delete Probe1.
15. Right-click (Control-click for Macintosh) Probe2 and select Edit Probe.
16. Clear the check box beside Speed.
17. To simulate the model, click the simulation button ( ) in the main toolbar. The following
graph is displayed.
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18. In the model workspace, click the parameter block.
19. In the Inspector tab, change the mass to 25, the length to 10, and the initial velocity to
5. These changes apply to all of the Sliding Mass components to which you assigned the
symbolic parameter values.
20. Simulate the model again. Another simulation graph, which you can compare to your
first first graph, is displayed. In this example, the curve shifts vertically after you run a
simulation with the new parameter values.

2.7 Creating and Managing Custom Libraries
You can create a custom library to save a collection of subsystems, custom modeling components, or attachments that you plan to reuse in multiple files. Custom libraries are displayed
in custom palettes below the Examples palette in the Components tab at the left of the
model workspace, and saved as .msimlib files on your computer.
A sample custom palette with a subsystem is shown below.
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Example: Adding Subsystems and Attachments to a Custom Library
In this example, you will add a subsystem and an .mw attachment to a custom library to
make them available in a future MapleSim session.
1. In the Components tab at the left of the model workspace, expand the Examples palette,
expand the Multidomain menu, and then open the Sliding Table example.
2. From the File menu, select Create Library...
3. Select a path and specify the file name Sliding Table.msimlib.
Note: This file will store the custom library and the file name that you specify will appear
as the custom palette name in the MapleSim interface.
4. Click Save. The Add to User Library dialog box is displayed.

5. Select the check box beside Motor to add the subsystem to the custom library.
6. Select the check box beside AdvancedAnalysis.mw to add the attachment to the custom
library.
7. Click OK. A new custom library palette is added in the Components tab at the left of
the model workspace.

2.8 Annotating a Model • 37

This palette and its contents will be displayed in the Components tab the next time you
start MapleSim.
8. In the Sliding Table palette, click Attachments. The Library Attachments dialog box
is displayed. This dialog box lists all of the attachments that you have added to the custom
library.

You can also use this dialog box to add attachments to the document folder of another
model and open attachments in their associated applications.
9. Close the dialog box.

2.8 Annotating a Model
You can use the tools in the drawing and layout toolbar to draw lines, arrows, and shapes
in the model workspace. MapleSim also provides many tools for customizing the colors,
line styles, and shape fills.

You can use the
tool in the drawing and layout toolbar to add text annotations to your
model. In text annotations, you can enter mathematical text in 2-D math notation and
modify the style, color, and font of the text. For more information about 2-D math notation,
see Entering Text in 2-D Math Notation (page 39).
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Example: Adding a Text Annotation to a Model
1. In the Components tab, expand the Examples palette, expand the Tutorial menu and
then open the Simple DC Motor example.
2. From the drawing and layout toolbar, click the text tool icon (

).

3. In the model workspace, draw a text box for an annotation below the Step component.

When you release your left mouse button, the toolbar above the model workspace switches
to the text formatting toolbar.

4. Enter the following text: This block generates a step signal with a height of 1.
5. Select the text that you entered and change the font to Arial.
6. Click anywhere outside of the text box.
7. Draw another text box below the Inertia component.
8. Enter the following text: Inertia with a
Tip: To enter the omega character (

value of 0 rad.

), press F5 to switch to the 2-D math mode, type

omega, and then press Ctrl + Space (Windows), Ctrl + Shift + Space (Linux), or Esc
(Macintosh). To enter the subscript, press Ctrl + Shift + the underscore key (Windows
and Linux) or Command + Shift + the underscore key (Macintosh) followed by 0. Press
the right arrow key to move the cursor from the subscript position.
9. Click anywhere outside of the text box.
10. Select the text that you entered and change the font to Arial.
11. Click anywhere outside of the text box to complete the annotation.
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2.9 Entering Text in 2-D Math Notation
In parameter values and annotations, you can enter text in 2-D math notation, which is a
formatting option for adding mathematical elements such as subscripts, superscripts, and
Greek characters. As you enter a phrase in 2-D math notation, you can use the command
and symbol completion feature to display a list of possible Maple commands or mathematical symbols that you can insert.
The following table lists common key combinations for 2-D math notation:
Task

Key Combination

Switch between text and 2-D
F5
math mode (annotations only)
1. Enter the first few characters of a symbol
name, Greek character, or Maple command.
2. Enter the key combination for your platform:
Command and symbol comple- Ctrl + Space (Windows)
tion (parameter values and
Ctrl + Shift + Space (Linux)
annotations only)
Esc (Macintosh)
3. From the menu, select the symbol or command
that you want to insert.
Enter a subscript for a variable

Ctrl (or Command) + Shift +underscore ( _ )

Enter a superscript

caret (^)

Enter a square root

Enter sqrt and press Ctrl (or Command for
Macintosh) + Space.

Enter a root

Enter nthroot and press Ctrl (or Command) +
Space.

Enter a fraction

forward slash (/)

Example
-

-
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Task

Key Combination

Example

Enter a piecewise, matrix, or
Ctrl (or Command) + Shift + R
vector row
Enter a table column

Ctrl (or Command) + Shift + C

For more information, see the Using MapleSim → Building a Model → Annotating a
Model → Key Combinations for 2-D Math Notation topic in the MapleSim help system.

2.10 The MapleSim Document Folder
You can use the MapleSim document folder to attach files in any format to a model (for
example, spreadsheets or design documents created in external applications). When you
attach files in the MapleSim document folder, those files are associated with the current
MapleSim model. You can save files attached in the document folder as part of the current
model and refer to them when you work with that model in a future MapleSim session.
The following is an image of a document folder that contains an attachment called DamperCurve.csv.

To browse the document folder associated with the current model, click the
the main toolbar.

button in

You can also use the MapleSim document folder dialog box to attach templates to perform
analysis tasks in Maple, create custom modeling components, and generate data sets for a
model. For more information about performing analysis tasks, see Analyzing and Manipulating a Model (page 75) in this guide.
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2.11 Creating a Data Set for an Interpolation Table
Component
You can create a data set to provide values for an interpolation table component in your
model. For example, you can provide custom values for input signals, and electrical Current
Table and Voltage Table sources. To create a data set, you can either attach a Microsoft®
Excel® spreadsheet (.xls) or comma-separated values (.csv) file that contains the custom
values, or you can create a data set in Maple using the Data Generation Template or Random
Data Template provided in the MapleSim document folder dialog box.
For more information about interpolation table components, see the MapleSim Library
Reference →Signal Blocks → Interpolation Tables → Overview topic in the MapleSim
help system.

Example: Creating a Data Set in Maple
In this example, you will use the Data Generation Template to create a data set for a
MapleSim 1D Lookup Table component. In this template, you can use any Maple commands
to create a data set; however, for demonstration purposes, you will create a data set using
a computation that has already been defined.
1. Open a new MapleSim document.
2. In the Components tab, expand the Signal Blocks palette, and then expand the Interpolation Tables menu.
3. Drag a 1D Lookup Table component to the model workspace.
4. From the main toolbar, click

to open the document folder dialog box.

5. From the drop-down menu, select Data Generation.
6. Click New.
7. Enter My First Data Set and click OK.
8. In the document list, select My First Data Set and click Open Selected. The Data Generation Template is opened in Maple.
9. To execute the entire worksheet, click

at the top of the window.

10. At the bottom of the template, in the Data set name field, enter TestDataSet.
11. To make the data set available in MapleSim, click the Attach Data in MapleSim button.
12. In MapleSim, open the document folder. The data set file (TestDataSet.mpld) is displayed in the list.
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You can now assign this data set to the interpolation table component in the model workspace.
13. Close the document folder dialog box.
14. In the model workspace, select the 1D Lookup Table component.
15. In the Inspector tab, from the data drop-down menu, select the TestDataSet.mpld file.
The data set is now assigned to the 1D Lookup Table component.
16. Save the Data Generation Template in Maple and then save your model in MapleSim.

2.12 Best Practices: Building a Model
This section describes best practices to consider when planning, laying out, and building a
MapleSim model.

Best Practices: Laying Out and Creating Subsystems
To start creating your system model, drag components from the palettes to the center of the
model workspace. Drag the components into the arrangement that you want in the model
workspace and then, if necessary, change their orientation so that the components are facing
in the direction that you want. When you have established the position and orientation of
the components, connect them in the model workspace.
When grouping components into subsystems, make sure that you include logical component
groupings that fit on one screen at a time. This will allow you to see all of the subsystem
components at a certain level without scrolling.
Create Subsystems for Component Groupings That You Plan to Reuse
Consider creating subsystems for component groupings that you plan to reuse throughout
a system or in multiple files. For example, if you plan to include multiple planar link models
in a pendulum system, consider creating a link subsystem so that multiple instances of that
component grouping could be added to a model from the Library Models palette. If you
wanted to add the link subsystem to another pendulum model, you could then create a custom
library to reuse the subsystem in the other file.
Create Subsystems for Component Groupings That You Plan to Analyze
Make sure that you create subsystems for component groupings that you plan to analyze in
more depth, test, or translate into source code. Several templates in the MapleSim document
folder allow you to retrieve equations and perform analysis tasks on individual subsystems,
in addition to the top level of your system; the Code Generation Template allows you to
generate source code from subsystems only.
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For more information about performing analysis tasks, see Analyzing and Manipulating a
Model (page 75) in this guide.

Best Practices: Building Electrical Models
Include a Ground Component in Electrical Circuits
In each electrical circuit model, you must add and connect a Ground component to provide
a reference for the voltage signals.
Verify the Connections of Current and Voltage Sources
Simulation results can be affected by the way in which a current or voltage source is connected in your model. If you receive unexpected simulation results, verify the connections
between electrical sources and other components in your model. All of the current sources
in the MapleSim component library display an arrow that indicates the direction of the
positive current.

Also, all of the voltage sources display a plus sign indicating the location of the positive
voltage and a minus sign indicating the location of the negative voltage.

Consider the following DC motor model. Note that the positive port of the Signal Voltage
source at the left of the diagram is connected to the positive port of the Resistor component.

When this model is simulated, MapleSim returns the following results for the speed and
torque quantities.
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On the other hand, if the negative port of the Signal Voltage source is connected to the
positive port of the Resistor component, as shown in the following image

MapleSim returns different results for the speed and torque quantities.

Best Practices: Building 1-D Translational Models
Verify That All Force Arrows Are Pointed in the Same Direction
In MapleSim, all of the 1-D translational mechanical components are defined in a 1-D coordinate system with the positive direction defined as the direction of the gray arrow displayed by the component icon.
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Any positive forces acting on the model will cause the component to move in the direction
of the arrow. To generate expected simulation results, make sure that all of the arrows displayed by the 1-D translational mechanical component icons in your model point in the
same direction. As an example, note that all of the force arrows are pointed to the right in
the following multiple mass spring-damper model.

Best Practices: Building Multibody Models
Connect the Inboard Port of a Rigid Body Frame to a Center-of-mass Frame
Make sure that you connect the inboard port of any Rigid Body Frame components in your
model to the center-of-mass frame of a Rigid Body component. This ensures that the local
reference frame used to describe displacements and rotations for the Rigid Body Frame
component match with the center-of-mass reference frame defined on the Rigid Body
component.
In the following planar link example, the Rigid Body Frame inboard ports (that is, the ports
with the cross-hatched circles) are both connected to a Rigid Body component.

Best Practices: Building Hydraulic Models
Define Fluid Properties
When building hydraulic models, you must define the properties of the fluid that will be
used by placing the Hydraulic Fluid Properties component at the top level of your model
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or at same level as a hydraulic subsystem. If you place this component at the top level of
your model, all hydraulic components and subsystems in your model will inherit the fluid
properties defined by that component instance; if you place the Hydraulic Fluid Properties
component at the same level as a subsystem, all hydraulic components in that subsystem
and all nested subsystems will inherit the properties defined by that component instance.
In the following example, all of the hydraulic components in the model inherit the fluid
properties defined by the Hydraulic Fluid Properties component at the top-right of the
diagram.

3 Creating Custom Modeling
Components
In this chapter:
•

Overview (page 47)

•

Opening Custom Component Examples (page 48)

•

Example: Nonlinear Spring-Damper Component (page 48)

•

Working with Custom Components in MapleSim (page 53)

•

Editing a Custom Component (page 54)

3.1 Overview
To extend the MapleSim library, you can create custom modeling components based on
mathematical models that you define. For example, you can create a custom component to
contain a particular subsystem and to provide specialized functionality.
By using the Custom Component Template, which is a Maple worksheet available through
the MapleSim document folder dialog box, you perform the following tasks in Maple to
create a custom component:
•

Define the component equations and properties that determine the behavior of the
component (for example, parameters and port variables)

•

Test and analyze your mathematical model

•

Add ports to the component and define the associated port variable mappings

•

Generate the component and make it available in MapleSim

The Custom Component Template contains pre-built controls that allow you to perform
these tasks. Each generated custom component is associated with a particular template and
each template can be associated with one .msim file at a time.
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3.2 Opening Custom Component Examples
The following custom component examples are available with your MapleSim installation:
•

Custom component defined with an algebraic equation

•

A sample DC motor component defined with a differential equation

•

A sample nonlinear spring-damper component

•

Custom component defined with a transfer function

To open an example:
1. In MapleSim, click the document folder button (

) in the main toolbar.

2. Click More Templates...
3. In the Browse Templates dialog box, open the Component Templates folder.
4. Select the example that you want to open, and click Attach Template...
5. In the Enter Document Name dialog box, enter a name for the template.
6. Click OK.
7. In the document list, select the template entry and click Open Selected. The sample
Custom Component Template is opened in Maple.

3.3 Example: Nonlinear Spring-Damper Component
In this example, you will use the Custom Component Template to create a nonlinear springdamper custom component. The equations defined in this example are based on the
Translational Spring Damper component in MapleSim. In this case, the stiffness and
damping coefficients are replaced with input functions to the component.
To obtain the governing relationships, you can start with a free-body diagram. The diagram
for the spring-damper system is shown below.
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The end points, a and b, can be defined as the ports for the component; the equations are
derived relative to these ports. Therefore, the general equation of motion,

where

is the damping coefficient,

displacement between the two ports

is the stiffness of the spring, and
and

is the relative

, can be written as

Also, an examination of the net force on the system shows that

, where

All of the above relationships are required to define the system behavior.

Opening the Custom Component Template
To start, open the Custom Component Template from the MapleSim document folder dialog
box.
1. In MapleSim, open the model to which you want to add the custom component.
2. Click the document folder button (

) in the main toolbar.
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3. From the drop-down menu, select Custom Component.

4. Click New.
5. Enter Nonlinear Spring-Damper as the name for the template and click OK.

6. In the document list, select the Nonlinear Spring-Damper entry and click Open Selected.
The Custom Component Template is opened in Maple.

Defining the Component Name and Equations
You can now specify the name that will be displayed for the component in the MapleSim
interface, a variable to store the equations, and the equations.
To define the component equations, you create a system model by using commands from
the DynamicSystems package. For more information, see the ?DynamicSystems topic in
the Maple help system.
1. In the Component Description section of the template, specify a component name called
NonLinearSpringDamper.
2. In the Component Equations section, delete the default equations below the table that
defines the variables.
3. To define the nonlinear system, enter the following equations.
>

>
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>
Note that the equations are entered in a Maple list. The constants,
(damping) and
(stiffness) are replaced by the functions
and
to define them as input states to the
system.
4. To assign the equations and the input and output definitions to a system object variable
called sys, enter the following text.
>

5. Click

at the top of the window to execute the entire worksheet.

You can now assign these input and output variables to ports that you will include in your
generated custom component.

Defining Component Ports
In the Component Ports section of the template, you assign input and output variables to
ports that will appear in the generated component, and specify the layout of these ports.
1. To remove the sample ports from the diagram, click Clear All Ports.
2. Click the Add Port button four times. Four squares, which represent the ports that you
will lay out and define, are displayed in the diagram.

3. Select the port on the left side of the diagram.
4. From the Port Type drop-down menu below the diagram, select Translational Flange.
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5. In the Port Components table, in the Position row, select s[b](t) from the drop-down
menu and, in the Force row, select F[b](t) from the drop-down menu. The left port is now
defined as a translational flange and associated with the position variable s[b](t) and force
variable F[b](t).
6. Select the port on the right side of the diagram.
7. From the Port Type drop-down menu, select Translational Flange.
8. In the Position row, select s[a](t) from the drop-down menu and, in the Force row, select
F[a](t) from the drop-down menu. The right port is now defined as a translational flange
and associated with the position variable s[a](t) and force variable F[a](t).
9. Select the port at the top of the diagram.
10. From the Port Type drop-down menu, select Signal Input.
11. In the Value row, select c(t) from the drop-down menu. This port is now defined as a
signal input and associated with the stiffness variable c(t).
12. Select the port at the bottom of the diagram.
13. From the Port Type drop-down menu, select Signal Input.
14. In the Value row, select d(t) from the drop-down menu. This port is now defined as a
signal input and associated with the damping variable d(t).
15. Drag the port that you defined in step 14 and place it at the top right of the diagram.
You can also drag the other port to position it.

The ports will be displayed in this arrangement when you generate the custom component
in MapleSim.
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Generating the Custom Component
To generate the custom component, click the Generate MapleSim Component button at
the bottom of the template. When it is generated, the custom component is displayed in the
Library Models palette located in the Project tab in MapleSim.

You can now add the NonLinearSpringDamper custom component to a model by dragging
it into the model workspace.

3.4 Working with Custom Components in MapleSim
In MapleSim, you can work with a custom component in the same ways as you would work
with a subsystem. You can perform the following tasks:
Add Text and Illustrations to a Custom Component
To customize the appearance of a custom component, you can change the default images
that are displayed in the component icon. Select the custom component in the model workspace, click
in the navigation toolbar, and use the drawing and annotation tools to add
text and illustrations.
Save a Custom Component as Part of the Current Model
To save a custom component as a part of the current model, add the component by dragging
it into the model workspace and then save the model. The next time you open the file, the
custom component will be displayed in the model workspace and Library Models palette.
Add a Custom Component to a Custom Library
If you want to use a custom component in a file other than the current model, add the component to a custom library. For more information, see Creating and Managing Custom
Libraries (page 35).
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3.5 Editing a Custom Component
If you want to edit a custom component that you have generated, make your changes in the
corresponding Maple worksheet and regenerate the component.
1. In the MapleSim model workspace, double-click the custom component that you want
to edit. The corresponding Custom Component Template is opened in Maple.
2. In the Maple worksheet, edit the equations, properties, or port values.
3. At the bottom of the worksheet, click Generate MapleSim Component. Your changes
are generated in the custom component displayed in MapleSim.
4. Save your changes in the .mw file and the .msim file to which you added the custom
component.

4 Simulating and Visualizing a Model
In this chapter:
•

How MapleSim Simulates a Model (page 55)

•

Simulating a Model (page 58)

•

Managing Simulation Results (page 62)

•

Customizing Plot Windows (page 63)

•

Visualizing a Multibody Model (page 69)

•

Best Practices: Simulating and Visualizing a Model (page 74)

4.1 How MapleSim Simulates a Model
Modelica Description
The equations for many of the components from the MapleSim library are described using
the Modelica physical modeling language. The equations for multibody components, on
the other hand, are generated by a special-purpose engine, which uses advanced mathematical techniques to ensure that the equations are as concise and efficient as possible. These
equations are also converted to Modelica.
For more information about Modelica, visit http://www.modelica.org.

Model Description
Each component in your model contains a system of equations that describes its behavior;
these systems of equations can consist of purely algebraic equations or differential equations.
Also, a component may define any number of events, which can change the component
behavior during a simulation by enabling or disabling part of the equations in the system
or changing state values. Connections between two or more components generate additional
equations that describe how these components interact.

System Equations
In the next step in the simulation process, all of these equations are collected in one large
system. Parameter values are also substituted in during this phase. Now, the MapleSim
simulation engine has a potentially large system of hybrid differential algebraic equations.
Essentially, this means that the system has differential equations with algebraic constraints,
as well as discrete events.
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Simplified Equations
A process called "index reduction" is applied to reduce the algebraic constraints as much
as possible. Other symbolic simplification techniques also reduce the number of equations
and variables. Note that algebraic constraints may still be present in the equations after this
step. No information is lost during the simplification process and the full accuracy is preserved. At this point, initial values for all of the variables remaining in the system of equations
must be computed. This is a non-trivial step because typically only a small number of the
initial conditions is fixed in the system model. The remainder of the initial conditions must
be computed in such a way that the entire equation set is consistent.
You can set initial values for some of the variables by specifying parameter values for certain
components in the Inspector tab at the right of the model workspace. If the supplied initial
conditions are not consistent, an error will be detected during the simulation.

Initialization
After all of these preprocessing steps are complete, the numeric solving process can begin.
A sophisticated differential algebraic equation (DAE) solver based on the Rosenbrock integrator (for stiff systems) or rkf45 integrator (for non-stiff systems) is used to numerically
integrate the system of equations. Algebraic constraints are constantly monitored to avoid
constraint drift, which would otherwise affect the solution accuracy. The stiff solver is used
by default; it is a good choice for typical systems. In some cases, the non-stiff solver will
offer better performance. The non-stiff solver is a good option for models where all quantities vary at approximately the same rate.

Numeric Integration and Event Handling
During numeric solving (or "integration"), inequality conditions that are part of the model
are monitored and an event is triggered when one or more of these conditions change.
Whenever such an event is encountered, the numeric solver is stopped and the simulation
engine computes a new configuration of the system of equations based on the event conditions. This step also involves recomputing initial conditions for the new system configuration.
The solver is then restarted and continues to numerically solve the system until another
event is triggered or the simulation end time is reached.

Simulation Results
In the last step of the simulation process, the results are generated and displayed using
graphs showing the quantities of interest and, optionally for multibody mechanical systems,
a 3-D visualization window.
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The simulation process is summarized in the following chart:

Note that the information in this section is a simplified description of the simulation process.
For more information on the DAE solvers used by the simulation engine, see the
?dsolve,numeric help topic in the Maple help system.
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4.2 Simulating a Model
To view the behavior or response of physical properties (for example, current or voltage),
add probes to connection lines, ports, or components in your model. In MapleSim, probes
allow you to identify the variables of interest that are associated with connection ports.
If you add a probe to measure a through variable, an arrow is displayed to indicate the direction of the positive flow in the model workspace.

You can specify the duration for which to run a simulation, the type of solver to use, and
other parameter values for the solver, simulation engine, and 3-D visualization window.
After running a simulation, a graph is displayed for each specified quantity by default. If
you are simulating a multibody mechanical model, a 3-D visualization window is also displayed.
You can change the original probe or parameter values and run another simulation to compare
the results, and you can configure MapleSim to hide the 3-D visualization window when
you simulate a multibody model.

Simulation Parameters
At the top level of your model, in the Inspector tab, you can specify the duration of the
simulation and, optionally, parameter values for the solver, simulation engine, and 3-D
visualization window.
Parameter

Default

10

Description
End time of the simulation. You can specify any positive value,
including floating-point values.
Note: For all simulations, the initial start time is 0.
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Parameter

Default

Description
DAE solver used during the simulation.
• true: use a stiff DAE solver (Rosenbrock method).

stiff solver

true

•

false: use a non-stiff DAE solver (rkf45 method).

If your model is complex, you may want to use a stiff DAE
solver to reduce the time required to simulate a model.

adaptive

true

Specifies whether an adaptive solver or a fixed-step solver is
used to determine sampling periods for the simulation.
• true: use an adaptive solver. The sampling periods, as determined by the solver, vary throughout the simulation.
• false: use a fixed-step solver. The sampling periods are a
uniform step size throughout the simulation. You can specify
the size in the step size field.
If the state of your model changes rapidly, you may want to use
a fixed-step solver to reduce the time required to run the simulation.
Note: When a fixed-step solver is used, fewer sampling periods
may be represented in the simulation results. For the most accurate results, use an adaptive solver to run the simulation.

step size

0.0010

Uniform size of the sampling periods if you are using a fixedstep solver to run the simulation. You can specify a floatingpoint value for this option when the adaptive field is set to false.
The limit on the absolute error tolerance for a successful integration step if you are using an adaptive solver to run the simulation. You can specify a floating-point value for this option when
the adaptive field is set to true.
The limit on the relative error tolerance for a successful integration step if you are using an adaptive solver to run the simulation.
You can specify a floating-point value for this option when the
adaptive field is set to true.
Minimum number of points to be plotted in a simulation graph.
The data points are distributed evenly in the graph according to
the simulation duration value. You can specify a positive integer.

plot points

200

Note: This option allows you to specify the number of points
for display purposes only. The actual number of points used
during the simulation may differ from the number of points
displayed in the simulation graph.
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Parameter

compiler

Default

false

Description
Specifies whether a native C compiler is used during the simulation. When this option is set to true, Maple procedures generated by the simulation engine are translated to C code, which is
compiled by an external C compiler.
If your model is complex, you may want to set this option to
true to reduce the time required to run a simulation.

max. steps

400000

Maximum number of integration steps that occur before the
simulation stops automatically. You can specify a positive value,
or a value of zero or infinity, when the adaptive field is set to
true.
If your model is complex, you may want to increase this value
to prevent the simulation from stopping before it is complete.

You can specify the following parameter values for models containing multibody mechanical components:
Parameter

Default

Description
Direction of gravity.

The acceleration due to gravity of Earth at the surface.

3-D animation

9.81

The default units are in

true

Specifies whether the 3-D visualization window is displayed
after running a simulation. When this option is set to false, the
window is not displayed.

.
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Parameter

Default

Description

Specifies the playback duration of the 3-D animation, at
a 1x speed rate, in seconds. This value differs from the
value, which in comparison specifies the simulation duration represented in your simulation graphs. You can specify a floating-point value for this option when the 3-D
animation field is set to true.
You can specify a value in this field to increase or decrease
the speed at which an animation is played. For example,
if the value is set to 0.5 seconds, you can set the 3-D
3-D playback time

-

playback time value to 10 seconds to slow down the animation; an animation of the 0.5 second simulation would
then be played back over a span of 10 seconds in real time.
If no value is specified in this field, the 3-D playback
time value is the same as the value entered in the field:
an animation of a 10 second simulation, for example,
would be played back over a span of 10 seconds in real
time. The number of frames represented in an animation
is determined by the value specified in the plot points
field, and the 3-D playback time value multiplied by the
3-D sampling rate value.

3-D sampling rate

30

Number of frames per second to include in the 3-D animation
playback. You can to increase this value to create a smoother
transition between frames in your animation. You can specify
a positive integer for this option when the 3-D animation field
is set to true.
The number of frames represented in an animation is determined
by the value specified in the plot points field, and the 3-D
playback time value multiplied by the 3-D sampling rate value.

Base Radius

-

Specifies the radius of all the spheres displayed as implicit geometry in the 3-D visualization window. Cylinders displayed as
implicit geometry are sized proportionately to the spheres; any
attached shapes in your 3-D model are not affected by this value.
You can use this option, for example, to view parts of your 3-D
model more closely during an animation. You can specify a
positive floating-point value.
If no value is specified in this field, MapleSim automatically
determines the default size for the implicit geometry.
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Simulation Progress Messages
During a simulation, you can view progress messages in the Console pane located below
the model workspace. These messages indicate the status of the MapleSim engine as it
generates a mathematical model; they can help you to debug simulation errors.

Optionally, before running a simulation, you can specify the amount of detail displayed in
progress messages by selecting a level from the drop-down menu at the bottom of the pane.

Storing Parameter Sets to Compare Simulation Results
You can store a group of parameter values assigned to a model in a parameter set. You can
then run a simulation using one parameter set, replace those parameter values with another
parameter set, and run another simulation to compare the results.
For more information, see the Using MapleSim → Building a Model → Saving and
Managing Parameter Sets section in the MapleSim help system.

4.3 Managing Simulation Results
The Stored Results palette in the Project tab at the left of the model workspace allows you
to view, save, and export results generated from multiple simulations. Whenever you simulate
a model, a Last Run - not saved entry is added to the Stored Results palette: you can click
that entry to view the graphs, progress messages, and (if applicable) 3-D visualization
window associated with that particular simulation run. As a result, you can compare and
refer to graphs generated from multiple simulations during a current MapleSim session.
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If you want to refer to a set of simulation results in a future MapleSim session, you can also
save the associated graphs, progress messages, and 3-D visualization window as part of a
model. When you open that model in a future MapleSim session, the simulation results
entry that you saved will be available in the Stored Results palette.
If you want to work with your simulation data in another application, you can also export
your results to a Microsoft Excel (.xls) or comma-separated value (.csv) file.
For more information, see the Using MapleSim → Building a Model →Managing Simulation Results section in the MapleSim help system.

4.4 Customizing Plot Windows
In a default plot window, quantities are plotted in separate simulation graphs that are displayed alphabetically according to probe and quantity names; in each graph, the quantity
values are plotted along the y axis versus the simulation time values along the x axis.
You can, however, create a custom plot window layout to plot a quantity along an axis that
you choose, specify the graph in which a quantity will appear in the plot window, customize
plot titles, add a second vertical axis to a graph, and specify the number of columns that
will appear in the plot window. You may want to create a custom plot window layout if,
for example, you want to compare multiple quantities in the same graph, plot one quantity
versus another, or view a simulation graph for a specific quantity without editing other
probe values.
To create a plot window layout, you specify attributes in the Plots tab at the right of the
model workspace.
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When you select the custom plot window layout from the drop-down menu, select the Show
Window check box, and then run a simulation, a custom plot window with the specified
attributes is displayed in addition to the default plot window. You can store multiple layouts
and select the one you want to use when you run a simulation.

Example: Plotting Multiple Quantities in Individual Graphs
In this example, you will create a custom plot window layout to plot and compare multiple
quantities in the generated simulation graphs.
1. In the Components tab, expand the Examples palette, expand the Multidomain menu,
and then open the Controlled 2 Link Robot example.
2. Click the Plots tab located at the right of the model workspace. The following table,
which displays all of the selected probe quantities, is displayed in the pane.
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This table displays the default layout of the graphs in the plot window that will be generated.
For example, this table indicates that the graph for the Joint1:Angle quantity will be displayed in the top-left corner of the plot window, the graph for the Joint1:Torque quantity
will be displayed in the top-right corner of the plot window, and so on after you run a simulation.
You will now create a custom plot window that displays both of the angle quantities in one
graph and both of the torque quantities in another graph.
3. From the drop-down list at the top of the pane, select Add Window.
4. In the Create Plot Window dialog box, specify a plot window layout name Angle and
Torque Comparison.
5. In the Columns field, type 2 and press Enter. The table in the pane now contains two
cells; each cell represents a plot window area for which you can specify layout attributes.

6. Click Empty in the left cell.
7. In the Title field, enter Angle.
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8. From the Primary Y-axis drop-down menu, select Joint1: Angle.
9. Click [Add Variable] below the drop-down menu.
10. From the second Primary Y-axis drop-down menu, select Joint2: Angle.
11. In the table at the top of the pane, click Empty in the top-right cell.
12. In the Title field, enter Torque.
13. From the Primary Y-axis drop-down menu, select Joint1: Torque.
14. Click [Add Variable] below the drop-down menu.
15. From the second Primary Y-axis drop-down menu, select Joint2: Torque. You can
now simulate the model using the new plot window layout.
16. Make sure that the Show Window check box in the Plots tab is selected.
17. Click the simulation button ( ) in the main toolbar. The following custom plot window,
which compares the angle values in one graph and the torque values in another, is displayed
in addition to the default plot window.

If you want to display the default plot window only, clear the Show Window check box in
the Plots tab and simulate your model again.

Example: Plotting One Quantity Versus Another
In this example, you will create a custom plot window layout to plot the X and Y position
of each of the links of a double pendulum.
1. In the Components tab, expand the Examples palette, expand the Multibody menu, and
then open the Double Pendulum example.
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2. From the drawing and layout toolbar, click the probe icon (
3. Click the right port of the

).

subsystem.

4. From the Select probe properties dialog box, select Length[1] and Length[2] and click
OK.
5. Click the probe once to position it in the model workspace.
6. Add another probe that measures the Length[1] and Length[2] quantities to the right
port of the
subsystem.
7. Click the Plots tab at the right of the model workspace.
8. From the drop-down list at the top of the pane, select Add Window.
9. In the Create Plot Window dialog box, specify a plot window layout name X versus Y.
10. Click Empty in the table at the top of the pane.
11. In the Title field, enter Bottom Link.
12. From the X-axis drop-down menu, select Probe4: r_0[1]
13. From the Primary Y-axis drop-down menu, select Probe4:r_0[2].
14. In the table at the top of the pane, click Empty below the Probe4: r_0[2](t) cell.
15. In the Title field, enter Top Link.
16. From the X-axis drop-down menu, select Probe3: r_0[1].
17. From the Primary Y-axis drop-down menu, select Probe3:r_0[2].
18. Make sure that the Show Window check box is selected.
19. Click the simulation button ( ) in the main toolbar. The following custom plot window
is displayed, in addition to the default plot window.
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The plots above show the motion of the end point of each link in the pendulum. The bottom
link follows a more chaotic path because of the interaction of the top link.

Plot Window Toolbar and Menus
After simulating a model, you can use the tools in the plot window to customize curves,
axes, and gridlines; navigate simulation graphs; and export simulation graphs to several
image formats. The following menus and toolbar are displayed at the top of each generated
plot window.

You can hover your mouse pointer over any of the toolbar buttons to view their descriptions.
For more information about these tools, see the Using MapleSim → Simulating a Model
→ Working with Simulation Graphs section of the MapleSim help system.
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4.5 Visualizing a Multibody Model
In MapleSim, the 3-D visualization environment allows you to view animated 3-D graphical
representations of multibody mechanical systems. You can view the components in your
model as 3-D graphic objects and visualize your simulation results by playing an animation
that depicts the projected movement of these components. As you build a model and change
its parameters, you can validate the 3-D configuration of elements and visually analyze the
system behavior under different conditions.
In the 3-D visualization environment, you can view your model from all angles in 3-D space
and control animation playback options to focus on certain components and animation
frames. Also, you can attach 3-D shapes to parts of your model to create a realistic-looking
system representation. These shapes can either be imported from an external CAD file or
selected from the Multibody →Visualization palette in the Components tab. You can also
attach trace lines to show where components will move during an animation.
For more information about adding 3-D shapes and using the 3-D visualization environment,
see the Using MapleSim → Visualizing a Model section of the MapleSim help system.

The 3-D Visualization Window
When you simulate a multibody mechanical system, the simulation graphs are generated
and the 3-D visualization window is displayed. This window contains the following components:
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Component

Description

1. Toolbar

Contains tools for hiding and displaying components in the window,
changing the 3-D model view, and specifying camera tracking options.
The area in which you view and animate a 3-D model. The arrows at the
origin indicate the directions of the world axes. They are displayed in the
following colors:

2. Viewport

•

X - red

•

Y - green

• Z - blue
You can use the grid as a reference to determine the relative sizes and positions of elements in your 3-D model. Grid size and gridline spacing are
based on the physical size of your model.
3. Playback controls

Controls for animating a 3-D model.

You can hover your mouse pointer over any of the buttons to view their descriptions.

Viewing and Navigating 3-D Models
In the viewport, you can view and navigate a 3-D model from the perspective view or one
of the orthographic views. The perspective view allows you to examine and navigate a
model from all angles in 3-D space. It allows you to see 3-D spatial relationships between
elements in your model because the "perspective" effect displays objects that are closer to
the camera larger than those that are further away from the camera.
Orthographic views use parallel projection as opposed to perspective projection. As a result,
your 3-D model appears as a flattened object because no depth information is shown. Orthographic views are sometimes referred to as "true length" views because they display undistorted lines and distances in the view plane that is perpendicular to the objects. These views
are useful for analyzing spatial relationships or clearances between objects.
You can navigate a model and change the model view while an animation is playing. In
both types of views, you can pan and zoom into or out from your model. In the perspective
view, you can also move the camera to view your model from above or below, and from
any direction around your model.

Adding Shapes to a 3-D Model
By default, basic spheres and cylinders called implicit geometry are displayed in the viewport
to represent physical components in your model. For example, consider the following double
pendulum model created in MapleSim.
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This model contains two revolute joints and two subsystems that represent planar links.
After simulating this model, the implicit geometry of the pendulum model is displayed as
follows in the 3-D visualization window.

The spheres represent the rigid bodies and the cylinders represent the planar links.
To create a more realistic representation of your model, you can add shapes and lines called
attached shapes to your model. You first add and connect attached shape components from
the Multibody palette to your diagram in the model workspace.
When you simulate your model, the attached shapes are displayed in addition to the implicit
geometry in the viewport. In the following image, shapes have been added to represent the
pendulum stem and bob pictorially. Also, a trace line, as represented by the curved line in
the image, is used to depict the locus of points that will be traced by a particular part of the
model during a simulation.

You can customize the color, size, scale, and other visual aspects of attached shapes by
setting parameter values for individual components in the Inspector tab before simulating
the model.
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If you want to view only the implicit geometry in the 3-D visualization window, you can
hide the attached shapes by clicking the

button in the toolbar. Similarly, if you want to

view the attached shapes only, you can hide the implicit geometry by clicking the

button.

For more information about attached shape components, see the MapleSim Library Reference → Multibody → Visualization → Overview topic in the MapleSim help system.
Note: If your multibody model contains Flexible Beam components, bending of the beam
will not be depicted in the implicit geometry of the 3-D model.

Example: Adding Attached Shapes to a Double Pendulum Model
In the following example, you will add cylinder shapes to represent the pendulum stem and
a sphere component to represent the pendulum bob. You will also add a Path Trace component to display the path along which the revolute joint will move during an animation.
1. In the Components tab, expand the Examples palette, expand the Multibody menu, and
then open the Double Pendulum example.
2. Expand the Multibody palette, and then expand the Visualization menu.
3. From this menu, add two Cylindrical Geometry components below the planar link
subsystems in the model workspace.
4. Connect the components as shown below.

5. From the same menu, add an instance of a Spherical Geometry component and place it
beside the
subsystem to the right of the model workspace.
6. Right-click (Control-click for Macintosh) the Spherical Geometry component and select
Flip Horizontal.
7. Add a Path Trace component and place it between the two Cylindrical Geometry
components.
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8. Connect the components as shown below:

9. Select the first Cylindrical Geometry component (

) in the model workspace.

10. In the Inspector tab on the right side of the window, change the radius of the cylinder
to 0.3 m.
11. To specify a cylinder color, click the box beside the color field. The color selection
dialog box is displayed.
12. Click one of the color swatches.
13. Select the second Cylindrical Geometry component (

) in the model workspace.

14. Change its radius to 0.3 m and change its color.
15. To simulate the model, click the simulation button ( ) in the main toolbar. The simulation graphs are displayed and the viewport displays the 3-D representation of your model
with attached shapes.

16. To play the animation, click the

button at the bottom of the 3-D visualization window.
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4.6 Best Practices: Simulating and Visualizing a Model
This section describes best practices to consider when simulating and visualizing a model.
Use an External C Compiler to Run Simulations With Longer Durations
When you set the compile parameter to true in the Inspector tab, Maple procedures generated by the simulation engine are translated to C code and then compiled by an external C
compiler. As a result, the time required to run a simulation can be reduced. In general, when
you use a C compiler to simulate a model, the compilation process will be faster in simulations with longer durations.
Compare Results Generated By Sections of Your Model
For debugging purposes, you may want to view simulation results for a specific section or
subsystem in your model. By selecting a section in your model and clicking the
button
above the model workspace, you can exclude part of your model from the next simulation
that you run. When you simulate your model, results will be displayed only for the model
sections that you did not exclude. This feature allows you to view simulation results generated
by specific sections in your model and compare results without having to delete components
from the model workspace or create multiple files.
For more information, see the Using MapleSim → Simulating a Model → Comparing
Results Generated By Sections of Your Model topic in the MapleSim help system.
Preview Multibody Models Before Running a Simulation
Before simulating your multibody model, consider previewing your 3-D model to view the
initial 3-D orientation of the elements in your model without generating simulation data.
By clicking the multibody preview button ( ) in the main toolbar, you can verify the orientation of components such as rigid bodies and rigid body frames, and view the initial
orientation of the axis throughout your multibody model. This feature is useful for verifying
whether your model has been built correctly and whether your initial conditions are set the
way you want.
For more information, see the Using MapleSim → Visualizing a Model → Previewing
the 3-D Configuration of a Multibody Model topic in the MapleSim help system.

5 Analyzing and Manipulating a
Model
In this chapter:
•

Overview (page 75)

•

Retrieving Equations and Properties from a Model (page 77)

•

Analyzing Linear Systems (page 78)

•

Optimizing Parameters (page 79)

•

Generating C Code from a Model (page 81)

•

Working with Maple Embedded Components (page 82)

5.1 Overview
MapleSim is fully integrated with the Maple environment, so you can use Maple commands,
embedded components, plotting tools, and many other technical document features to analyze
and manipulate the dynamic behavior of a MapleSim model or subsystem. For example,
you can use Maple to retrieve and work with model equations, test input and output values,
translate your model into C code, and perform many other advanced analysis tasks.
To start working with your model in Maple, you can use the templates available through
the MapleSim document folder dialog box. These templates are Maple worksheets with
pre-built tools for model building and analysis tasks: you first create a MapleSim model
and open it in one of the available templates to perform an analysis task in Maple.
The following templates are available:
Template Name

Task

Code Generation Template

Translate your model into C code.

Custom Component Template

Create a custom modeling component based on a mathematical model. For more information, see Creating Custom
Modeling Components (page 47).

Data Generation Template

Define and generate a data set to be used in MapleSim, for
example, a data set for an interpolation table component.
For more information, see Creating a Data Set for an Interpolation Table Component (page 41).

Equation Analysis Template

Retrieve equations from linear or nonlinear models.

Linear System Equation Template

View and analyze the equations of a linear system.
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Template Name

Task

Monte-Carlo Simulation Template

Define a random distribution for a parameter and run a
simulation using the distribution.

Parameter Optimization Template

Analyze and edit the parameters of a model and view possible simulation results in a graph.

Random Data Template

Define and generate a set of random data points to be used
in MapleSim, for example, a data set for an interpolation
table component.

Sensitivity Analysis

Perform parameter sensitivity analysis.

Alternatively, to edit and analyze a model, you can insert a MapleSim Model embedded
component into a Maple worksheet and open an existing MapleSim model in that component.
For more information about the MapleSim Model component, see Working with Maple
Embedded Components (page 82).
Both methods of performing analysis tasks allow you to use commands from any Maple
packages, including MapleSim and DynamicSystems, to work with your model programmatically.
Note: After using a document folder template, save the .mw file and then save the .msim
file to which the .mw file is attached.
Tip: The pre-built analysis tools available in each template are Maple embedded components,
which allow you to interact with Maple code through graphical interactive components.
The code associated with each embedded component uses commands from Maple packages,
including MapleSim and DynamicSystems.
To view the code associated with an embedded component, right-click (Control-click for
Macintosh) any of the tools in the Maple worksheet, select Component Properties, and
click Edit. For more information about embedded components, see the ?EmbeddedComponents topic in the Maple help system.

Working with Equations and Properties in a Maple Worksheet
When viewing and working with equations or properties in a template, note the following:
•

The programmatic names of certain parameters, variables, and connectors displayed in
the Maple worksheet differ from the names displayed for the corresponding elements
in the MapleSim interface. For example, if an Inertia component is included in a model,
the parameter for the initial value of the angular velocity is displayed as

in the

MapleSim interface and w_start in a Maple worksheet. For more information about the
mappings of element names, see the MapleSim Library Reference Guide in the
MapleSim help system.
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•

Subscripts and superscripts displayed in the MapleSim interface are represented differently in a Maple worksheet. Subscripts in the MapleSim interface are displayed with an
underscore character in a Maple worksheet. For example, a connector called
in
the MapleSim interface would be displayed as flange_a in a Maple worksheet. Also,
superscripts are formatted as regular characters in a Maple worksheet. For example, a
variable called
worksheet.

in the MapleSim interface would be displayed as

in a Maple

5.2 Retrieving Equations and Properties from a Model
You can use the Equation Analysis Template to retrieve and analyze equations and properties
such as parameters, initial equations, and variables in your model.
1. In MapleSim, open the model for which you want to retrieve equations or properties.
2. Click the document folder button (

) in the main toolbar.

3. From the drop-down menu, select Equations.
4. Click New.
5. Enter a name for the template and click OK.
6. In the document list, select the template entry and click Open Selected. Your model is
opened in the Equation Analysis Template in Maple.
7. In the Equation Analysis Template, click System Update.
8. If applicable, from the drop-down menu, select the subsystem for which you want to view
equations. By default, the drop-down menu is set to Main, which allows you to view
equations for the entire system.
9. To retrieve model equations, click Get Equations. The equations are displayed.
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Alternatively, to retrieve model properties, click the button for the property that you want
to view.
10. To work with the equations or properties, assign them to a variable by clicking the Assign
to variable button.
You can now manipulate the equations using any Maple packages, for example, DynamicSystems and MapleSim. For more information about these packages, see the ?DynamicSystems and ?MapleSim help topics in the Maple help system.

5.3 Analyzing Linear Systems
You can use the Linear System Analysis Template to view and analyze the equations of a
linear system, test system input and output values, and view possible simulation results in
a Bode or root locus plot.
1. In MapleSim, open the linear system model that you want to analyze.
2. Click the document folder button (

) in the main toolbar.

3. From the drop-down menu, select Analysis.
4. Click New.
5. Enter a name for the template and click OK.
6. In the document list, select the template entry and click Open Selected. Your model is
opened in the Linear System Analysis Template in Maple.
7. In the Linear System Analysis Template, click System Update.
8. From the drop-down menu, select the subsystem for which you want to perform linear
analysis.
Note: By default, the drop-down menu is set to Main, which allows you to view equations
and properties for the entire system using the tools in the Model Equations section of the
worksheet. To perform linear analysis using the tools in the Analysis and Simulation section
of the template, you must select a subsystem; linear analysis cannot be performed on the
entire system.
9. To retrieve model equations, click Get Equations. The equations are displayed in the
worksheet.
Alternatively, to retrieve model properties, click the buttons for the properties that you want
to view.
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10. Assign the equations or properties to a variable by clicking the Assign to variable button.
You can now use the embedded components provided in the Analysis and Simulation
section of the template to perform analysis tasks.
11. Define system input and output values. To add a value, select an entry from the System
IO and probes menu, and click

. To add all of the values, click

.

12. Click Build System Object.
You can now select a parameter from the list, change the value of that parameter, and use
the plotting tools at the bottom of the worksheet to view possible simulation results.

5.4 Optimizing Parameters
You can use the Parameter Optimization Template to test various conditions using the embedded components provided in the worksheet and view possible simulation results in a
plot.
Tip: You can also use commands from the Global Optimization Toolbox to perform parameter optimization tasks. For more information about this product, visit the Maplesoft
Global Optimization Toolbox web site at http://www.maplesoft.com/products/toolboxes/globaloptimization/.
1. In MapleSim, open the linear system model that you want to analyze.
2. Click the document folder button (

) in the main toolbar.

3. From the drop-down menu, select Optimization.
4. Click New.
5. Enter a name for the template and click OK.
6. In the document list, select the template entry and click Open Selected. Your model is
opened in the Parameter Optimization Template in Maple.
7. In the Parameter Optimization Template, in the Parameter Investigation section, click
Retrieve System Parameters.
8. Specify the simulation time, solver, and number of points to be used in the plot.
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9. In the table below the Number of points field, from the first drop-down menu, select the
parameter that you want to test.

Note: When a parameter is selected, its assigned value is displayed in the field next to the
slider.

10. In the Range fields beside the slider and parameter value field, specify the range of the
slider. By default, the range is 0 to 10 unless the selected parameter value is outside of this
range.
11. Using the process described in steps 9 and 10, in the rows below your first entry, specify
other parameters that you want to test.
When you have defined all of the parameters, you can move the sliders to test different
values and view possible simulation results in the plot. You can also assign the parameters
you defined to a Maple procedure to perform further analysis tasks in the Parameter Optimization section of the template.
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5.5 Generating C Code from a Model
If you want to use or test your model in an application that supports the C programming
language, you can use the Code Generation Template to translate a subsystem in your
model into source code.
1. In MapleSim, open the model for which you want to generate code.
2. Make sure that the components for which you want to generate code are grouped in a
subsystem.
3. Click the document folder button (

) in the main toolbar.

4. From the drop-down menu, select Code Generation.
5. Click New.
6. Enter a name for the template and click OK.
7. In the document list, select the template entry and click Open Selected. Your model is
opened in the Code Generation Template in Maple.
8. In the template, click System Update.
9. From the drop-down menu, select the subsystem for which you want to generate code.
10. (Optional) If you want to retrieve model equations, click Get Equations. The equations
are displayed. Alternatively, to retrieve model properties, click the buttons for the properties
that you want to view.
11. To assign the equations to the variable eq, click the Assign to variable button.
12. In the Code Generation Setting section, select the input and output values for your
system and click Build System Object.
13. In the Generating Code section, click Code Generation.
14. Click Save C Function Library. A dialog box prompts you to save your code as a C
file.
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5.6 Working with Maple Embedded Components
In Maple, you can use the MapleSim Model embedded component to view, edit, and analyze
the properties of MapleSim models programmatically. For example, you can view and
change parameter values using commands in the DocumentTools package. Model or subsystem equations can be retrieved using routines from the MapleSim package and you can
manipulate your model as a DynamicSystems object to analyze the model or subsystem
behavior using any input functions.
You can also associate model properties with other Maple embedded components, including
sliders and plots to create custom analysis tools.
For more information about advanced analysis tasks, open the Sliding Table example from
the Examples → Multidomain palette in the Components tab, and open the Advanced
Analysis Worksheet from the MapleSim document folder.
For more information about the MapleSim Model component, see the ?MapleSimModel
topic in the Maple help system.

6 MapleSim Tutorials
In this chapter:
•

Tutorial 1: Modeling a DC Motor with a Gearbox (page 83)

•

Tutorial 2: Modeling a Cable Tension Controller (page 89)

•

Tutorial 3: Modeling a Nonlinear Damper (page 93)

•

Tutorial 4: Modeling a Planar Slider-Crank Mechanism (page 99)

6.1 Tutorial 1: Modeling a DC Motor with a Gearbox
In this tutorial, you will extend a DC motor model and perform the following tasks:
1. Add a gearbox to the DC motor model.
2. Simulate the DC motor with gearbox model.
3. Group the DC motor components into a subsystem.
4. Assign global parameters to the model.
5. Add signal block components and a PI controller to the model.
6. Simulate the modified DC motor model using different conditions.

Adding a Gearbox to a DC Motor Model
In this example, you will build the gearbox by adding and connecting an ideal gearbox
component, a backlash component with a linear spring and damper, and an inertia component
from the 1-D Mechanical library.
1. In the Components tab, expand the Examples palette, expand the Tutorial menu, and
then open the Simple DC Motor example.
2. Perform the following tasks:
•

From the 1-D Mechanical → Rotational → Bearings and Gears menu, add an Ideal
Gear component to the model workspace and place it to the right of the Inertia component.

•

From the 1-D Mechanical →Rotational → Springs and Dampers menu, add an
ElastoBacklash component to the model workspace and place it to the right of the Ideal
Gear component.
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•

From the 1-D Mechanical → Rotational → Common menu, add another Inertia
component to the model workspace and place it to the right of the ElastoBacklash
component.

Tip: Use the selection tool ( ) in the drawing and layout toolbar to drag and position
components in the model workspace.
3. Connect the components as shown below.

4. In the model workspace, click the Ideal Gear component.
5. In the Inspector tab, change the transmission ratio to 10 and press Enter.
6. Specify the following parameter values for the other components:
•

For the ElastoBacklash component, in the b field, change the total backlash value to
0.3 rad. In the d field, change the damping constant to

•

For the first Inertia component (
to 10 kg

•

.

), in the J field, change the moment of inertia value

.

For the Step source, in the height field, change the value to 100.

Simulating the DC Motor with Gearbox Model
1. Delete Probe1 from the model workspace.
2. From the drawing and layout toolbar, click the probe button (

).

3. Hover your mouse pointer over the line that connects the ElastoBacklash component
and the second Inertia component ( ). The line is highlighted.
4. Click the line once. The Select probe properties dialog box is displayed.
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5. To include the angle (

), speed (w), acceleration (a), and torque (

) values in the sim-

ulation graphs, select Angle, Speed, Acceleration, and Torque.
6. Click OK.
7. Click the probe to position it on the line.
8. In the Inspector tab at the right of the model workspace, set the

parameter to 10

seconds and press Enter.
9. Click the simulation button ( ) in the main toolbar. When the simulation is complete,
the following graphs are displayed.

Grouping the DC Motor Components into a Subsystem
1. Using the selection tool (
inertia component.

), draw a box around the electrical components and the first
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2. From the Edit menu, select Create Subsystem.
3. In the Create Subsystem dialog box, enter DC motor.
4. Click OK. A white block, which represents the DC motor, is displayed in the model
workspace.
Tip: To view the components in the subsystem, double-click the DC motor subsystem in
the model workspace. To browse to the top level of the model, click the Main button in the
navigation toolbar.

Assigning Global Parameters to a Model
You can define a global parameter and assign its value as a variable to multiple components
in your model.
1. Click Main in the navigation toolbar to browse to the top level of the model.
2. From the navigation toolbar, click the

button to switch to the parameter editor view.

3. In the first row of the Main subsystem default settings table, define a parameter called
R and press Enter.
4. Specify a default value of 24 and enter Global resistance variable as the description.
5. In the second row of the table, define a parameter called J and press Enter.
6. Specify a default value of 10 and enter Global moment of inertia value as the description.

6.1 Tutorial 1: Modeling a DC Motor with a Gearbox • 87

7. To switch to the diagram view, click the
button in the navigation toolbar. The new R
and J parameters are displayed in the Inspector tab below the max. steps field.

You can now assign these parameter values to other components in your model.
8. From the navigation toolbar, click the
9. In the

button to switch to the parameter editor view.

component table, in the value field for the moment of inertia parameter, enter

J and press Enter.
The moment of inertia parameter now inherits the numeric value of the global parameter,
J (in this example, 10).
10. Switch to the diagram view and double-click the DC Motor subsystem.
11. In the navigation toolbar, click the
12. In the
enter

button to switch to the icon view.

component table, in the value field for the transformation coefficient,
and press Enter.

Note: This value is an approximation of the transformation coefficient.
13. In the

component table, in the value field for the resistance parameter, enter R and

press Enter.
14. Switch to the diagram view and browse to the top level of your model.
15. Save the model as DC_Motor2.msim.

Changing Input and Output Values
In this example, you will change the input and output values of the model to simulate different
conditions.
1. From the 1-D Mechanical → Rotational → Sensors menu in the Components tab, add
the Angular Velocity Sensor component to the model workspace and place it below the
gearbox components.

88 • 6 MapleSim Tutorials

2. Right-click (Control-click for Macintosh) the Angular Velocity Sensor component and
select Flip Horizontal.
3. Delete the connection line between the Step source and the DC Motor subsystem.
4. From the Signal Blocks → Controllers menu, add the PI component to the model
workspace and place it to the left of the DC Motor subsystem.
5. From the Signal Blocks → Mathematical → Operators menu, add the Feedback
component to the model workspace and place it to the left of the PI component.
6. Connect the components as shown below.

Tip: To draw a perpendicular line, click a point in the model workspace to anchor the line
and then move your mouse cursor in a different direction to draw the second line segment.
7. Click the PI component in the model workspace.
8. In the Inspector tab, specify a gain of 20 in the k field, and a time constant of 3 seconds
in the T field.
9. Simulate the model again. When the simulation is complete, the following graphs are
displayed.
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10. Save the model as DC_Motor3.msim.

6.2 Tutorial 2: Modeling a Cable Tension Controller
In this tutorial, you will extend the DC motor example to model a cable that is stretched
with a pre-defined tension. The tension is defined by a Constant source and the PI controller
provides the voltage to drive the motor. You will perform the following tasks:
1. Build a cable tension controller model.
2. Specify component properties.
3. Simulate the cable tension controller model.
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Building a Cable Tension Controller Model
In this example, you will build the cable tension controller model using a combination of
1-D mechanical rotational and translational components. You will also group components
into a Gear subsystem and add subsystem ports.
1. Open the DC_Motor3.msim file that you created in the previous tutorial and save the
file as Cable_Tension.msim. Alternatively, open the DC Motor with PI Control example
in the Examples → Tutorial palette.
2. Delete Probe3 attached to the line connecting the ElastoBacklash and Inertia components.
3. Delete Angular Velocity Sensor component and its connection lines.
4. Select the ElastoBacklash, Ideal Gear, and Inertia components and group them into a
subsystem called Gear Components.
5. Add the following components to the model workspace:
•

From the 1-D Mechanical → Rotational → Bearings and Gears menu, add the Ideal
Rotation to Translation Gear component and place it to the right of the Gear Components subsystem.

•

From the 1-D Mechanical → Translational → Sensors menu, add the Force Sensor
component and place it to the right of the Ideal Rotation to Translation Gear component.

•

From the 1-D Mechanical → Translational → Springs and Dampers menu, add the
Translational Spring component and place it to the right of the Force Sensor component.

•

From the 1-D Mechanical → Translational → Common menu, add the Translational
Fixed component and place it to the right of the Translational Spring component.

6. Right-click (Control-click for Macintosh) the Translational Fixed component in the
model workspace and select Rotate Counterclockwise.
7. Delete the Step source and replace it with a Constant source from the Signal Blocks →
Sources → Real menu.
Tip: You can connect the Constant source by dragging it onto the unattached line end.
8. Double-click the Gear Components subsystem. You will now add a port to connect this
subsystem with other components.
9. Click the negative (white) flange of the Inertia component and drag your mouse cursor
to the boundary that surrounds the subsystem components.
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10. Click the line once. The subsystem port is added to the line.

11. Click Main in the navigation toolbar to browse to the top level of your model.
12. Connect the components as shown below.

Specifying Component Properties
1. In the model workspace, double-click the Gear Components subsystem.
2. Specify the following parameter values for the subsystem components:
•

For the Ideal Gear component, change the transmission ratio value to 0.01.

•

For the Inertia component, change the moment of inertia value to 0.1

3. Click Main in the navigation toolbar to browse to the top level of the model.
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4. Specify the following parameter values for the other components:
•

For the Translational Spring component, in the c field, change the spring constant
value to

.

•

For the PI controller, change the T value to 0.1 s.

•

For the Constant source, in the k field, change the constant output value to 77.448.

Simulating the Cable Tension Controller
1. Click the probe button (
ponents.

) and click the line that connects the Feedback and PI com-

2. In the Probe Properties dialog box, select Real, change the quantity name to Error, and
click OK.
3. Click the probe once to position it on the line.
4. Add a probe that measures the Real quantity to the line connecting the PI component
and DC motor subsystem. Change the quantity name to Controller.

6. In the Inspector tab, specify a

value of 5 seconds and make sure that the stiff solver

option is set to true.
7. Click the simulation button ( ) in the main toolbar. When the simulation is complete,
the following graphs are displayed.
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8. Save the file as CableTension.msim.

6.3 Tutorial 3: Modeling a Nonlinear Damper
In this tutorial, you will model a nonlinear damper with a linear spring. This tutorial builds
upon the concepts demonstrated in the previous tutorials. You will perform the following
tasks:
1. Generate a custom spring damper defined by differential equations.
2. Provide custom damping coefficient values as input signals.
3. Build the nonlinear damper with linear spring model.
4. Assign a variable to a subsystem.
5. Simulate the nonlinear damper with linear spring model.

Generating a Custom Spring Damper
In MapleSim, you can create a custom component that is based on a mathematical model.
Typically, you would define the component equations and ports before making the component
available in MapleSim. For the the purpose of this tutorial, you will generate a sample custom
component with pre-defined differential equations.
1. Open a new MapleSim document.
2. Click the document folder button (

) in the main toolbar.

3. Click More Templates...
4. In the Browse Templates dialog box, browse to the Component Templates folder.
5. Select the NonLinearMSD.mw file and click Attach Template...

94 • 6 MapleSim Tutorials

6. In the Enter Document Name dialog box, enter NonLinearMSD.
7. Click OK. An instance of the template is attached to the MapleSim document folder.
8. Select the entry that you created and click Open Selected. The Custom Component
Template is opened in Maple.
9. To generate the component, click Generate MapleSim Component at the bottom of the
worksheet.
In MapleSim, the NonLinearMSD component is displayed in the Library Models palette,
in the Project tab, at the left of the window.

You will use this component later in this tutorial.

Providing Damping Coefficient Values
You can provide custom values for interpolation table components that you add to your
model. In this example, you will provide damping coefficient values in an external file.
1. Create either a Microsoft Excel spreadsheet or comma-separated values (.csv) file that
contains the following values:

The first column contains values for the relative displacement of the damper and the second
column contains values for the damping coefficients.
2. Save the file on your hard drive as DamperCurve.xls or DamperCurve.csv.
3. In MapleSim, click the document folder button (

) in the main toolbar.
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4. Click Attach...
5. Browse to and select the Excel spreadsheet or .csv file that you created, and click Attach...
The file containing the data set is attached to your model. You will use this file in the next
task.
6. Close the dialog box.

Building the Nonlinear Damper Model
1. From the Library Models palette, drag the NonLinearMSD component into the model
workspace.
2. Add the following components to the model workspace:
•

From the Signal Blocks → Mathematical → Operators menu, add a Gain component
and place it above the NonLinearMSD component.

•

From the Signal Blocks → Sources → Real menu, add a Constant component and
place it between the NonLinearMSD and Gain components.

•

From the Signal Blocks → Interpolation Tables menu, add a 1D Lookup Table
component and place it to the left of the Gain component.

•

From the 1-D Mechanical → Translational → Sensors menu, add a Position Sensor
component and place it to the left of the 1D Lookup Table component.

3. Connect the components as shown below.

4. Add the following components to the model workspace:
•

From the 1-D Mechanical → Translational → Common menu, add a Translational
Fixed component, rotate it counterclockwise, and place it to the right of the NonLinearMSD component.
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•

From the same menu, add Sliding Mass and Force components and place them to the
left of the Position Sensor component.

•

From the Signal Blocks →Sources → Real menu, add a Step source.

5. Connect the components as shown below.

6. In the model workspace, select the 1D Lookup Table component. In the Inspector tab,
the data drop-down menu lists all of the documents that you have attached to the model.
7. Select the DamperCurve.xls or DamperCurve.csv file that you created in the previous
task.

You will now define the stiffness of the spring.
8. In the model workspace, select the Constant component.
9. In the Inspector tab, in the Component field, change the component name to Stiffness.

10. Select the Step component and change the step height to 100.
11. Select the Sliding Mass component and change the mass to 100 kg.
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12. Using the selection tool (
damper model.

), draw a box around all of the components in the nonlinear

13. Group the selected components into a subsystem called Nonlinear damper. The complete
model is shown below.

Assigning a Parameter to a Subsystem
1. In the model workspace, double-click the Nonlinear damper subsystem.
2. To switch to the parameter editor view, click the

button in the navigation toolbar.

3. In the first row of the Nonlinear damper subsystem default settings table, define a
spring constant parameter called Ks and press Enter.
4. In the same row, specify a default value of 1000 and enter Spring constant as the description. You can now assign the parameter value to other components in the Nonlinear damper
subsystem.
5. To switch to the diagram view, click
in the navigation toolbar. The Ks parameter is
now displayed as a field in the Inspector tab with the default value that you defined.
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6. In the model workspace, select the Stiffness component and change the constant output
parameter, k, to Ks.

This component now inherits the numeric value of Ks (in this example, 1000). Therefore,
if you edit the numeric value of Ks at the subsystem level, the k parameter that has been
assigned the variable, Ks, also inherits that change.

Simulating the Nonlinear Damper with Linear Spring Model
1.From the drawing and layout toolbar, click the probe button (

).

2. Click the line that connects the Gain and NonLinearMSD component.
3. In the Select probe properties dialog box, select the Real quantity and change its name
to Damping.
4. Click OK and position the probe on the line.
5. Browse to the top level of the model.
6. To the line that connects the Sliding Mass component and the Nonlinear damper subsystem, add a probe that measures the length, speed, and acceleration quantities.
7. In the Inspector tab, set the

parameter to 10 seconds.
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8. Click the simulation button ( ) in the main toolbar. When the simulation is complete,
the following graphs are displayed.

9. Save the file as NonLinearMSD.msim.

6.4 Tutorial 4: Modeling a Planar Slider-Crank
Mechanism
Using components from the Multibody mechanical library, you will model the planar slidercrank mechanism shown in the following schematic diagram.
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This model consists of a revolute joint, A, which is attached to a planar link. This planar
link is attached to a connecting rod by a second revolute joint, B. The connecting rod is then
connected to a sliding mass by a third revolute joint, C, and the sliding mass is connected
to ground by a prismatic joint. In practice, this mechanism is used to convert rotational
motion at the crank to translational motion at the sliding mass or vice versa. For the system
shown in the diagram, gravity is assumed to be the only external force, acting along the
negative Y axis (the y axis for the inertial frame).
In this tutorial, you will perform the following tasks:
1. Create a planar link subsystem
2. Define and assign subsystem parameters.
3. Create the crank and connecting rod elements.
4. Add the fixed frame, sliding mass, and joint elements to the model.
5. Specify initial conditions.
6. Simulate the planar slider-crank mechanism.

Creating a Planar Link Subsystem
The diagram above shows that the slider-crank has two associated planar links: the crank
(the link from point A to B) and the connecting rod (the link from B to C). In both cases,
these links have their longitudinal axis along their local x axis (x1 and x2, respectively).
Therefore, you will first create a generic planar link with two ports. The inboard port (base)
will be located
located

units along the x axis of the link, and the outboard port (tip) will be

units along the x axis of the link. In this example,

refers to the length of the

link and the center-of-mass is assumed to be in the middle of the link.
1. Open a new MapleSim document.
2. From the Multibody → Bodies and Frames menu in the Components tab, add two
Rigid Body Frame components and a Rigid Body component.
3. In the model workspace, right-click (Control-click for Macintosh) the

component

and select Flip Horizontal.
4. Right-click (Control-click for Macintosh) the Rigid Body component and select Rotate
Counter Clockwise.
5. Drag the components in the arrangement shown below.
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You can now connect the components.
6. Draw a connection line between the Rigid Body component and the right frame of the
component.

7. Draw another connection line between the Rigid Body component and the left frame of
the
component.

8. Using the selection tool (

), draw a box around the components.

9. From the Edit menu, select Create Subsystem.
10. In the Create Subsystem dialog box, enter Link and click OK.
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You will now add ports to connect this subsystem to other components.
11. Double-click the Link subsystem.
12. Click the left frame of the

component and drag your mouse pointer to the left

of the subsystem boundary.

13. Click the line once. A subsystem port is added.
14. In the same way, using the right frame of the
the right side of the subsystem boundary.

component, create another port on
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Defining and Assigning Parameters
In this task, you will define a subsystem parameter, L, to represent the length of the link
and assign the parameter value as a variable to the parameters of the Rigid Body Frame
components. The Rigid Body Frame components will then inherit the numeric value of L.
1. To display the parameter editor view, click the

button in the navigation toolbar.

2. In the first row of the Link subsystem default settings table, define a parameter called
L, and press Enter.
3. Specify a default value of 1 and enter Length as the description.
4. From the navigation toolbar, click

to switch to the diagram view.

5. In the Inspector tab, specify the following parameter values:
•

For the

component, in the

field, specify an offset of

•

For the

component, in the

field, specify an offset of

Tip: To enter a fraction, use the forward slash key (/).

Creating the Crank and Connecting Rod Elements
In this task, to create the crank and connecting rod elements, you will add another instance
of the Link subsystem to your model and rename the subsystems. You will also assign a
different length value to the connecting rod element.
1. Click Main in the navigation toolbar to browse to the top level of your model.
2. Select the Link subsystem in the model workspace.
3. In the Inspector tab, in the Component field, change the name of the subsystem to
Crank.
4. From the Library Models palette, drag the Link icon to the model workspace and place
it to the right of the
subsystem.
5. In the model workspace, select the second instance of the Link subsystem.
6. In the Inspector tab, change the subsystem name to ConnectingRod and change the
length value to 2.
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Adding the Fixed Frame, Sliding Mass, and Joint Elements
In this task, you will add a Fixed Frame component, a Rigid Body component to represent
the sliding mass, and the joint elements.
1. From the Multibody → Bodies and Frames menu, add the Fixed Frame component
and place it to the left of the Crank subsystem.
2. From the same menu, add a Rigid Body component and place it slightly below and to
the right of the Connecting Rod subsystem.
3. Add the following joints:
•

From the Multibody → Joints and Motions menu, add a Revolute joint between the
Fixed Frame component and the crank, a second Revolute joint between the crank and
the connecting rod, and a third Revolute joint between the connection rod and the sliding
mass.

•

From the same menu, add a Prismatic joint and place it below the Crank subsystem.

4. Select the

component in the model workspace and rename it Sliding Mass.

5. Right-click (Control-click for Macintosh) the Sliding Mass component and select Flip
Horizontal. In the same way, flip the the
revolute joint horizontally.

6. Connect the components as shown below.
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Tip: In this example, the default axes of motion for the revolute and prismatic joints line
up with the desired axes of motion. For example, the revolute joints initially assume that
they rotate about the z axis of the inboard frame, which always coincides with the inertial
Z axis for XY-planar systems. If you create nonplanar models, you may need to change
these axes to make sure that they allow motion along or about the correct directions.

Specifying Initial Conditions
To specify initial conditions, you can set parameter values for certain components in your
model.
1. For the first revolute joint, in the

field, change the initial angle of the joint to

rad.
Tip: To enter
and select the
2. From the

, type Pi, press Ctrl + Space (or Command + Shift + Space for Macintosh),
symbol from the menu.
drop-down menu, select Strictly Enforce.

When MapleSim solves for the initial conditions, the first angle will be set to
rad before the angles are set for the other joints.

Simulating the Planar Slider-Crank Mechanism
1. From the drawing and layout toolbar, click the probe button (

).

2. In the model workspace, click the white 1-D translational flange at the top right of the
Prismatic joint icon.
3. In the Select probe properties dialog box, select the Length quantity to measure the
displacement.
4. Click OK and position the probe on the connector.
5. In the same way, add a probe that measures the Angle quantity to the white 1-D rotational
flange at the top right of the
joint icon.
6. In the Inspector tab, set the

parameter to 10 seconds.
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7. Click the simulation button ( ) in the main toolbar. When the simulation is complete,
the following graphs are displayed.

8. Save the file as SliderCrank.msim.

7 Reference: MapleSim Keyboard
Shortcuts
Opening, Closing, and Saving a Model
Task

Windows and Linux Shortcuts

Create a new model

Ctrl + N

Command + N

Open an existing model

Ctrl + O

Command + O

Close the active document

Ctrl + F4

Command + W

Save a model as an .msim file

Ctrl + S

Command + S

Macintosh Shortcuts

Exporting and Printing a Model
Task

Windows and Linux Shortcuts

Export a model as an image

Ctrl + E

Command + E

Print a model

Ctrl + P

Command + P

Macintosh Shortcuts

Building a Model
Task

Windows and Linux Shortcuts

Macintosh Shortcuts

Rotate the selected modeling componCtrl + R
ent 90 degrees clockwise

Command + R

Rotate the selected modeling componCtrl + L
ent 90 degrees counter-clockwise

Command + L

Flip the selected modeling component
Ctrl + F
vertically

Command + F

Flip the selected modeling component
Ctrl + H
horizontally

Command + K

Group the selected modeling componCtrl + G
ents into a subsystem

Command + G

Display or hide probes in the model
Ctrl + D
workspace

Command + D
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Navigating a Model
Task

Windows and Linux Shortcuts

View the selected modeling componCtrl + M
ent or subsystem in detail

Macintosh Shortcuts
Command + M

Zoom in to the model workspace

Ctrl + numeric keypad plus Command + numeric keypad
plus key
key

Zoom out from the model workspace

Ctrl + numeric keypad
minus key

Command + numeric keypad
minus key

Drawing and Layout Tools
Shortcuts (all platforms)
Switch to the selection tool

S

Switch to the eraser tool

E

Switch to the text box tool

T

Switch to the line tool

L

Switch to the rectangle tool

R

Switch to the oval tool

O

Index
Symbols
2-D math notation, 39
3-D display controls
Attached shapes, 71
Implicit geometry, 70
Trace lines, 72
3-D view navigation, 70
3-D views
Orthographic, 70
Perspective, 70

E
Embedded components, 82
MapleSim Model, 82
Equations
Retrieving, 77
Error tolerance, 59

G
Global parameters, 86

I
Initial conditions, 20
Interpolation tables, 94

A

L

Acausal modeling, 2
Annotations, 37

Library Models palette, 23
Linear systems
Analyzing, 78

B
Best practices, 42, 74

C
Causal modeling, 2
Code generation
C, 81
Connection lines, 18
Colors, 18
Connection ports, 18
Custom components
Defining equations, 50
Defining ports, 51
Editing, 54
Examples, 48
Overview, 47
Custom libraries, 35
Custom plot window, 63

D
Differential algebraic equations, 1
Document folder, 40, 75
Drawing, 37

M
MapleSim component library, 6, 15
Mathematical model, 1
Model tree, 16
Model workspace, 6
Modelica, 55
Modeling components
Connecting, 9

N
Non-stiff solver, 56

P
Palettes, 6, 15
Parameter block, 31
Parameter optimization, 79
Parameter values, 10
Parameters
Global parameters, 28
Parameter sets, 62
Parameter values, 19
Subsystem parameters, 30
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Physical models
Analyzing, 75
Building, 7
Navigating, 16
Probes, 58
Adding, 11
Progress information messages, 62

S
Simulating, 58
Simulation parameters, 58
Compiler, 60
Simulation results
Comparing, 62
Exporting, 63
Managing, 62
Viewing, 62
Solvers
Adaptive, 59
Fixed-step, 59
Stiff solver, 56, 59
Subsystems, 21
Editing multiple instances, 25
Managing, 23
Multiple instances, 24

T
Templates
Code Generation, 81
Custom Component, 49
Equation Analysis, 77
Linear System Analysis, 78
Parameter Optimization, 79

U
Units, 19

V
Variables, 3
Visualization, 69

